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1      Getting Started with the Zimbra Web Client
The Zimbra Web Client (ZWC) is a full-featured messaging and collaboration 
application that offers reliable, high-performance email, address books, 
calendaring, task lists, and Web document authoring capabilities.

This chapter explains how to: 

• Select the version of ZWC to use

• Log in and log out

• Navigate your account

• Use Zimbra Assistant

• Learn about the availability of shortcut keys

Note:  Some accounts will not include all the features mentioned in this guide. 
Check with your administrator to see which features are enabled for your 
account.

Advanced and Standard ZWC
The ZWC has two versions:

Advanced Web Client offers the full set of Ajax-based Web collaboration 
features. The advanced Web client works with newer browsers and faster 
Internet connections. 

Standard Web Client is a good option when Internet connections are slow or 
users prefer HTML-based messaging for navigating within their mailbox. 

This user guide describes the advanced ZWC. Many of the same features are 
available for the standard ZWC but may not be accessed as described in this 
guide. The differences between the advanced and standard versions of the 
ZWC are summarized in Appendix A: Standard and Advanced ZWC. Refer to 
the Help in the ZWC for more information about these features.
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Zimbra Web Client Components
The main ZWC components are Email, Address Book, Calendar, Tasks, 
Documents and Briefcase. User Preferences and Zimbra Assistant are also 
powerful ZWC features.

The features of each component are included in the following table.  

Component Features

Email

• Compose and send new email messages

• Include attachments with your message

• Read and reply to email messages

• Forward email messages to one or more recipients

• Track email exchanges using the Conversation feature 
(to view an entire message thread at once) or 
traditional message view

• Search email messages, attachments, and other ZWC 
areas

• Create your own folders to organize email

• Create tags to organize your email, contacts, etc.

• Create filters to route incoming email to designated 
folders

• Configure your ZWC account to receive email from 
your POP3 accounts 

• Share your email folders

Address Book

• Create and manage multiple address books

• Easily add contacts from email messages you receive

• Import and export contact lists

• Share your address books

Calendar

• Create and manage multiple calendars

• Create appointments, meetings, and events

• See attendee's free/busy schedules

• Import and export calendars

• Share your calendars
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Tasks

• Create multiple tasks lists

• Create to-do tasks

• Add attachments to your tasks

• Manage a task, set the priority, and track the progress

• Share your task lists 

Documents

• Create multiple notebooks to organize your Web 
documents

• Design pages using an HTML editor, create tables and 
spreadsheets, add graphics, and create links to Web 
pages

• Share your notebooks

Briefcase

• Upload any type of file to your briefcase so that you 
can access the file whenever you log on to ZWC

• Create folders to organize files that you upload

• Share your Briefcase folders

Preferences

• Manage how your mailbox features work for Email, 
Address Book, and Calendar

• Create email filters

• Set up forwarding to another email account

• Create notification messages, such as a vacation 
message, and designate when to turn them on and off

• Choose a different language to view a mailbox user 
interface

• Use different account identities (personas) and 
addresses to manage different roles in your job or 
personal life

Zimbra 
Assistant

Zimbra Assistant is a shortcut to:

• Create new appointments

• Go to a specific date in your calendar

• Create new contacts

• Send a new email message without leaving the 
application you are using
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Browser Compatibility
The Zimbra Web Client is designed to work within an Internet browser. The 
recommended browsers are Internet Explorer 7 or 8 or Firefox 3.0 and 3.5 or 
later. Not all browsers are supported, so check with your administrator if you 
have questions.

Follow these general guidelines when using the Zimbra Web Client within a 
browser:

• The browser's Back button takes you to the previous page you were 
viewing. You can also use the Forward button.

• Do not use the browser's Reload (Refresh) button. Doing so will restart 
your session.

Logging In
Open a browser window and enter the URL provided by your administrator. In 
most cases, Advanced is the default client and is opened automatically when 
you log in. 

Before you enter your name and password, you can switch to the standard 
web client or to the mobile client. 

You can change the default from your Preferences General folder after you log 
in.

To change the default to standard after logging in:

1. Select the Preferences > General folder.

2. Select either Advanced or Standard in the Login Options section.
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3. Click Save.

The next time you log in, your selection will be the default.

To log in

1. Open a browser window and enter the URL provided by your Zimbra 
administrator.

For example:

http://mail.domain.com/zimbra/mail

2. When the login screen appears, type your user name. You may be required 
to type your full email address as the user name and your password.  

Example of a full email address, type:

myra@example.com 
myra123

Your password displays as ****** on-screen, to protect your privacy.

To be remembered on this computer until the session expires or you log 
out, check Remember me on this computer.

If you check this, you will not have to log in every time you restart the 
browser during a day.  When this is checked and you do not log out, your 
session remains active until the session expires. The system administrator 
configures how long a session is active.

Note:  If you leave your web client open in your browser but do not access 
your mailbox for a period of time, your session may time out and then you 
will need to log back in.

If you do not want the default client type, change the version displayed.

3. Click Log In.
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To prevent others from logging in to your email account, you should always 
use the Log Out link to close your session.

Forget your password?

If you forget your password, contact your administrator to reset it for you.

If Your Session Expires
Your system may be configured with a session time-out that automatically logs 
you out if your session is inactive for a pre-configured period of time. 

Your administrator may also set a maximum session length, e.g.., a maximum 
amount of time that you can be logged in, regardless of whether any activity 
occurs or not.

Therefore, you may periodically see the login screen, even if you are already 
logged in. If that happens, simply log in again and continue working.

Navigating the Zimbra Web Client 
When you log in you see a full screen view similar to the one shown below. 
The view changes when you use another ZWC application. This view is the 
Mail view.
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Refer to the following table when viewing the ZWC.

Number Description

1

Window Header. Displays the following:

Search Bar - including the Save and Advanced buttons for 
ZWC searches

 and  are displayed on the right

2

Toolbar. Displays the following:

Tools Tabs – click a tab to access the different ZWC tools 
available for your account. In this example, Email is open.

Action Buttons – click an action button to perform a task 
available for the application you are currently using. In this 
example, the Email action buttons are displayed in the 
toolbar.
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Three Pane View

If you prefer to view your mail in a three-pane view: Navigation pane on left, 
Content pane in the second column and the Reading pane on the right, click 

the View icon, , on the toolbar and select Reading Pane on the Right.

3

Overview Pane. Displays the following:

User Name – the user name under which you logged in

Quota Display – your mailbox quota

Folders – including system folders (Inbox, Sent, Draft, 
Junk, Trash) and folders you created

Searches – search queries that you created and saved for 
future use

Tags – any tags you have created. Click on a tag to quickly 
see all messages that are tagged with that tag.

Zimlet – links that may have been created to integrate with 
third-party applications from within your mailbox. 
Depending on your configuration, you may not have access 
to Zimlets from the Overview Pane.

Mini-Calendar – optional. You can disable the mini-
calendar using the Preferences > Calendar folder.

4
Content Pane. The content of this area changes 
depending on what application is in use. In the Mail view, it 
displays all messages or conversations in your Inbox. 

5

Reading Pane. Email messages are displayed in the 
Reading Pane. In the email message shown here, you can 
see:

Contact Zimlet: Click a name in any email message to 
quickly add the name as a contact in an address book.

Meeting Zimlet: Click a meeting or appointment in any 
email message to quickly add the meeting to your calendar. 
Click a date to quickly see what appointments you have on 
that date.
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User Interface Features and Shortcuts
The Zimbra Web Client interface includes many convenient features.

Down-arrow menus. Some buttons 
have a small down-arrow icon next 
to them.

• Click on the button to perform 
one action (such as open a new 
compose window).

• Click on the down-arrow icon to 
display a drop-down menu of 
additional choices, as shown 
here.

Drag and drop. Click on and drag messages, conversations, tasks, etc. 
between folders.

Movable sash. For split-pane windows such as 
the Conversation view, you can use the sash to 
increase or decrease the relative sizes of the 
upper and lower panes. Click and drag on the 
bar separating the panes.
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Clickable items. Zimbra follows standard browser conventions by changing 
the mouse cursor to a hand when it passes over an active link. 

Tool-tips. Passing your mouse cursor over 
items, such as command buttons, conversations, 
or email addresses in message headers, 
displays a small text box of descriptive 
information about the item.

Right-click menus. Right-click on items (such as 
folders, conversations, messages,  or items in email 
headers) to display a menu of functions that you can 
perform on that item. This is an example of the right-
click menu on a user name in the Inbox From column.

The menu choices displayed depend on the type of 
item. Right clicking on the following displays right-click 
menus: 

• Conversations. You can mark conversations as 
read or unread, apply tags to conversations, delete 
conversations, or move conversations between 
folders.

• Messages. You can reply to or forward messages, 
mark as read or unread, apply tags to a message, 
delete a message, move it to another folder, print, 
show original header information, and create a new 
filter.

• Names in message headers. You can perform 
searches on the name, begin composing a new 
Email message addressed to that person, or add 
the person to your personal Contacts list. If the 
name is an existing contact, you can edit the 
contact entry.
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Folder Information. If you hover the cursor over a folder, the 
number messages in the folder and the size of the folder are 
displayed. 

Applying an Action to Multiple Selections

When you view a folder by clicking on the folder name in the Overview pane, 
the contents of the folder display with one item selected (highlighted). You can 
select one or more items to perform actions as follows:

• Click to select one item at a time. Click on another item to de-select the 
previous one.

• Double-click to open an item.

• Right-click an item to display a menu of actions that can be applied to this 
item. You can also right-click after selecting multiple items, to apply the 
same action to all of them at once.

• Control-click selects multiple items. Can also be used to de-select the 
current item, leaving nothing selected.

• Shift-click selects multiple items in sequence. Click on one item and then 
Shift-click another item further down the list. All items between the two 
selected items are highlighted.

You can select multiple items, and with one right-click, choose to Mark as 
Unread, Tag, Delete, or Move all selected items.

Zimbra Assistant
Zimbra Assistant is an advanced user feature that provides a quick way to 
interact with the ZWC using the keyboard to do the following tasks:

• Create new appointments

• Go to a specific date in your calendar

• Create new contacts

• Send a new Email message without changing the application you are 
currently using

You can open Zimbra Assistant from any ZWC view except the Preferences 
tab. 
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The keyboard shortcut to open Zimbra Assistant is to click the button with the 
tilde and back quote key. This key is frequently below the Escape (Esc) key on 
the keyboard.

To use Zimbra Assistant:

1. Click the tilde/back quote key from within the ZWC to open the Zimbra 
Assistant dialog. 

2. Click Help for detailed help on Zimbra Assistant.

3. Enter one of the following commands into the dialog:

• To create an appointment, type appointment. You can then enter a 
subject in quotes, the time, a date and day of week, and any notes for 
the appointment. Click OK. 

Note:  If you want more advanced appointment features, click More details 
to go to the Calendar Appointments page. See “Creating an Appointment or 
Meeting” on page 120.

• To go to a specific date in your calendar, type calendar and the date, or 
the day of the week. Click OK.

Note:  After the date you can enter the Calendar view you prefer: day, 
work-week, week, or month. The Calendar opens in that view.

• To create a new contact, type contact and enter the contact information. 
Click OK. 

Note:  If you want to open the Contacts detail form, click More Details. Use 
this form to specify which address book to use.

• To send an email without opening a compose window, type mail. Enter 
the subject in quotes; type to:name@address; and then type the body 
of the message.  Click OK. 
 12      



Getting Started with the Zimbra Web Client          
ZWC Keyboard Shortcut Keys
Many of the functions and commands in ZWC have associated keyboard 
shortcuts. To see a list of shortcut keys go to the Preferences > Shortcuts 
folder. The keyboard shortcut list can be printed. 

To see a list of shortcuts while working in your mailbox, click Ctrl+q. 
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2      Receiving and Managing Email 
This chapter explains how to:

• Customize your email page

• Navigate the email views

• Receive and read email messages

• Organize email messages

Customizing Your Initial Email Page
By default, your mailbox opens with the Inbox view. In this view, all messages 
in your Inbox are displayed in the Content pane. 

You can change the initial view to be any of the folders, searches, or tags in 
the Overview pane. Change your initial view using the Preferences > Mail 
folder.

To display only specific messages when you open your mailbox, use the 
Default Mail Search field on the Preferences > Mail folder.
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Here are some examples of how you can display only specific messages 
when you open your mailbox:

• To display only unread messages, type is:unread in the default mail 
Search field.

• To display messages that are tagged with specific tags, type 
tag:<tagname> in the default mail Search field. For example, to display only 
messages marked with the ToDo tag, type tag:ToDo. Tags are covered in 
Chapter 4.

• To display messages that you sent to a specific folder via an email filter, 
type in:<foldername> in the Default Mail Search field. For example, to 
display messages in the Work folder, type in:work. Filters are covered in 
Chapter 5.

Note:  Use quotes if the folder or tag is more than one word. For example 
in:"Unread Email."

Getting Your Email
Your computer checks to see if you have new mail based on the polling 
interval you have set up. The default is to check every 5 minutes. If you are 
expecting an email, you can click Get Mail any time to receive new email 
immediately.

You can create desktop alerts to notify you of the arrival of new email from the 
Preferences > Mail folder. 

Alert options you can set up include:

• Play a sound. You are notified by a beep when a new email arrives in your 
mailbox. If you have your volume set to mute, you do not here a sound. For 
this to work, you mush have either QuickTime or windows Media installed. 

• Highlight the Mail tab. The email tab is highlighted when new email arrives 
in the Inbox if you are not working in the Mail tab at the time.
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• Flash the browser title. when new email arrives in the Inbox, the browser 
flashes until you open the Mail tab.

• Show a popup notification. An email message alert pops up displaying 
information about the message. You must have Yahoo!BrowserPlus 
installed. To get a copy, go to http://browserplus.yahoo.com/

Email Views
If you receive dozens of email messages a day, you may want to group them 
to more quickly find what you are looking for.

Your ZWC mailbox offers two options for viewing the messages in your 
mailbox. You can toggle between the two views by clicking View and selecting 
either of the views.

Message view. Messages can be displayed in the Inbox by date. This is the 
traditional message view, where messages received today display the hour 
received, and messages received in previous days show the date received. 
The toolbar shows how many messages you are viewing and how many 
message are in your inbox.You can scroll through the Content pane to see 
more messages.

Conversation view. The Conversation view displays your messages grouped 
by subject, as shown below. Because all messages in a conversation have the 
same subject, the subject displays only once in the conversation view pane. 
All messages related to the conversation are displayed, even if they are stored 
in different folders. The toolbar shows how many conversations you are now 
viewing in the Content pane. You can scroll through to see more 
conversations.
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Parts of the Content Page View

Each message, in message or conversation view, has a separate line that 
displays the following columns of information.

• Check box. Use the checkbox to select one or more messages to perform 
the same action on, such as delete, move, mark as read. Check the box in 
the header will automatically check all the messages on the page.

• Conversation indicator. Is this email part of a conversation? If  is 
displayed, the message is part of a conversation. 

• Flag indicator. Did you flag this message to indicate an action-needed 
item or to otherwise distinguish the message or conversation from a larger 
number of other items of lesser importance?  

• Priority indicator. Did the sender mark this message as high priority?

• Tags. Did the message get marked by a Tag you defined?

• Status. Open or closed envelopes indicate whether a message has been 
read. Bold text also indicates that a message has not been read.

• From. Name or email address of the sender.

• Attachment indicator. A paper clip indicates that a message has an 
attachment.

• Subject. Brief description of the email message. If Snippets is enabled in 
your account, the first line of an email message is displayed.

• Folder. Shows the name of the folder where the message is located. For 
conversations, no folder name is displayed because messages can span 
multiple folders. When you open the conversation, this column displays 
where the message is located.

• Size. Size of the message or number of messages in the conversation.

• Received. Date or time the message was received.

How Do Conversations Work?

The Conversation view displays your messages grouped by subject, as shown 
below. Because all messages in a conversation have the same subject, the 
subject displays only once in the conversation view pane. All messages 
 18      



Receiving and Managing Email           
related to the conversation are displayed, even if they are stored in different 
folders. 

The number of messages in the conversation is displayed in parentheses in 
the Size column (after the subject). Each conversation consists of the original 
message and all replies. Conversations containing unread messages are 
shown in bold.

Messages in a Conversation

You can read messages grouped together in context and ordered by date, 
including replies and forwarded messages. Messages grouped in a 
conversation have the same subject.

For example, the following subject lines would be considered part of the same 
conversation.

Who's in charge of the project? 

Re: Who's in charge of the project? 

Fwd: Who's in charge of the project? 

If you change the subject to who's in charge of the project? - ask Mike, the 
message would not be included in this conversation.

Conversations do not continue indefinitely. If the last message in the 
conversation is 30 days old or older, messages sent with the same subject 
begin a new conversation.

Conversations Can Span Folders

If a conversation includes three email messages, one of those messages 
could be in your Inbox, your reply (which is also part of the conversation) will 
most likely be in your Sent folder, and another message could be in a custom 
folder.

If you search for email messages and one message is found that matches 
your search, but that message is in a conversation with several other 
messages that do not match your search, the entire conversation and all 
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messages within it are listed under the search results. When you open the 
conversation, only messages that match your search criteria are highlighted.

The same conversation may appear to exist in more than one folder. This can 
happen if the email messages are in different folders, either because you 
moved them there, or you applied a filtering rule that put them there when they 
were received.

Because a conversation is a group of related messages, if you move a 
conversation from one folder to another, all messages within that conversation 
are also moved to that folder. Sent messages and messages in the Trash 
folder, however, are not automatically moved. They remain in the folders.

Reading Email
To read an email message:

• Using Message view.

• If you have the Reading pane on, click on a message to display its 
contents in the Reading pane.

• If you do not have the Reading pane on, double-click on a message to 
display it in a separate window.

• Using Conversation view. Click the arrow in the conversation row 
containing the message. 

The Content pane changes to show the individual messages in the 
conversation. The Subject column shows the first line of the message 
body. 

• If you have the Reading pane on, click the line that contains the 
message you want to read. The message body appears in the Reading 
pane.

• If you do not have the Reading pane on, double-click the line that 
contains the message you want to read. The message body will fill the 
Content pane.

The Reading Pane

The Reading pane lets you read emails from your inbox without opening the 
email. Depending on your view, the Reading pane can be at the bottom or on 
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the right. By default, viewing messages in the Reading pane at the bottom is 
on. You can select the view from the View menu on the toolbar.

If you have the Reading pane on, when you click on an email message, the 
message displays in a pane and the message is marked as read. To adjust 
the size of the Reading pane, click and drag the divider bar up or down.

To turn the Reading pane off, click  the arrow next to View on the toolbar, and 
select Reading Pane. 

Displaying HTML in Email Messages

You can view email messages in two formats:

• Plain text.  Plain text messages are messages that contain no HTML 
formatting code. Messages sent in plain text can always be read by other 
email clients. You can view messages in plain-text mode even if it contains 
HTML. The HTML tags are displayed in the body of the message in the 
plain text view.

• HTML. HTML messages can have text formatting, numbering, bullets, 
colored background, and links which can make messages easier to read. 
Some email clients may not accept messages formatted in HTML.

To always view your email messages in HTML:

1. Use the Preferences>Mail folder. 

2. Check Display Mail As HTML (when possible).
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Messages will now be displayed in formatted layout, if they were sent in 
HTML.

Parts of an Email message

An email message is shown below.

A ZWC email message has two main sections:

• Header. The message header contains information concerning the sender 
and recipients, including the following information:

• Subject. Description of the topic of the message. A subject line could be 
something like 2007 company mission statement or, if your spam 
filtering application is too lenient, Lose weight fast!!! Ask me how.

• Sent By. Sender’s name and/or email address. This is the email 

address that becomes the recipient if you click . If the sender 
has specified a Reply-to address, your reply will be sent to that address 
instead.

• On. Date and time the message was received.

• To. Name and/or email address of the email recipient (where the 
message was actually sent).

• Attachments. Any files that were included in the email message. 
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• Body. The body of a message contains the content of the email. The 
message body also may include signatures or automatically generated text 
that is inserted by the sender's email system.

Viewing an Attachment

Email messages can include attached files, such as the following:

• Word processing documents

• Spreadsheets

• Text files

• .zip files

• Images (.bmp, .jpg, etc.)

• Executable applications

• Any other type of computer file that resides on the sender's computer 
network

Messages containing an attachment have an  icon displayed next to the 
subject. 

Some types of files, such as JPEG images or text files, can be opened on 
almost any computer system. Others, such as Microsoft Word documents, 
must be opened using the same application that created them.

To view an attachment, click on either the name of the attachment or the 
download link. Click Briefcase, to save the attachment to the ZWC Briefcase.

• Click the name of the attachment to open the attachment (if you have the 
correct application available).

• Click the Download link to open a dialog prompting you to open or save 
the file.
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If you choose Save to Disk, a browse dialog appears showing your file 
system. Choose a location and save the file. You can then open the file 
outside of your email client.

• Click Briefcase to save a copy of the attachment in your ZWC Briefcase 
folder. Select which Briefcase folder to save to. You can then click Remove 
to remove the attachment from the email. 

• Click Remove to remove the attachment from the message. Removing the 
attachment deletes the file from your mailbox. If you downloaded the file or 
saved it to your Briefcase, you still have a copy.

• Click Preview (if this is displayed) to open the attachment even if the 
application is not installed on your network. This feature is set by your 
administrator.

Marking an Email as Unread

The Zimbra Web Client (ZWC) marks messages that you open as read. 
Conversations containing unread messages are shown in bold. 

To change a message's status back from read to unread:

• Right-click the message.

• Choose . 

You can also mark a conversation as unread.

• Marking a conversation as unread marks all messages within that 
conversation as unread.
 24      



Receiving and Managing Email           
• Marking a single message as unread marks the conversation that contains 
the message as unread.

To change a message or conversation status back to read, do either of the 
following:

• Open the message or conversation.

• Right-click the message, and choose 

Setting Preferences for Marking Mail

You can change the settings for marking an email as read or unread in the 
Preferences> Mail folder. Selecting the desired option under When I read a 
message in the reading pane:. 

• Mark it read immediately. As soon as you click a message in the Reading 
Pane it is marked as read.

• Mark it read after  "x " seconds.  The default is 5 seconds. If you click on a 
message and view it for 5 seconds, the message is marked as read.

• Do not mark it read.  Messages you read in the Reading Pane are never 
marked as read.

Virus Safety

Computer viruses can spread through email attachments. It is standard 
practice for email administrators to implement virus filtering for incoming Email 
as well as virus scanning for personal computers. However, there is always a 
chance that a virus could get through.

Many email viruses are activated when a file attachment containing the virus is 
opened or viewed. Many of these viruses have been known to spread 
themselves using entries in users' address books. Therefore, use care when 
opening file attachments, even from senders you know.
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Printing an Email Message
To print an email message:

1. Click on the message you want to print.

2. Click  in the toolbar. A standard print dialog appears. 

3. Choose a printer.

4. Click . The message is sent to the selected printer.

Note:  Do not use the browser's File > Print feature. The page will not be well-
formatted, and your message may be difficult to read.

To print a conversation (all messages):

1. Right-click the conversation to be printed, and select Print. You must be in 
Conversation view.

Two windows appear:

• One window, as shown below, shows all the messages in the conversation 
in a single scrolling window, and the total number of messages to be 
printed is displayed at the top. 
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Note:  If you want to adjust the size of the print font before you print, close 
the dialog that opens and click the + or - next to Font size in the top right 
corner. After you set the font size, click the browser Print button.

• The other window is a standard print dialog. In the print dialog:

1. Choose a printer.

2. Click OK. The message is sent to the selected printer.

3. Close the window.

Organizing Email Messages Using Folders
ZWC provides the following methods for organizing email messages. You can 
use these along with the Search feature to quickly locate and retrieve 
messages.

• Folders. You can create folders to organize your messages, and you can 
move email between folders. Use of folders is covered in this chapter.

• Filters. In the Preferences > Mail Filters folder, you can create rules for 
classifying inbound email according to items in the subject line, sender, 
recipient, or other characteristics. Filters are covered in Chapter 5.

• Tags. You can use tags as labels on email messages and then use the 
Search feature to show all email with a certain tag. Tags are covered in 
Chapter 4.
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Mail System Folders Overview
The mail system folders are Inbox, Sent, Drafts, Junk, and Trash. You 
cannot move, rename, or delete these folders. System folders are always 
displayed at the top of your folder list, followed by any folders you create.

Refer to the following table for more information on the ZWC mail system 
folders.

Folder 
Name Description

Inbox
New email arrives in the Inbox. Your Inbox is displayed by 
default after you log in.

Sent
A copy of each message you send is saved in the Sent 
folder.

Drafts

Messages you have composed but have not sent can be 
saved in the Drafts folder. Messages are automatically 
saved to the Drafts folder as you compose. If you navigate 
away from a message you have not sent, you will be asked if 
you want to save the message as a draft.

Junk

Most filtering of unsolicited automated email (also known as 
spam or junk mail) is handled by a spam filter before those 
email messages reach your Inbox. Email that might possibly 
be junk mail, but isn't certain to be junk, can be placed in 
your Junk folder.

You can review these messages and either move them or 
delete them. If you don't delete them, they will be purged 
after a period of time, as specified by your administrator.

Trash

Deleted items are placed in the Trash folder and remain 
there until you manually empty the trash or until the folder is 
purged automatically. Email is purged from this folder after a 
specified period of time, as specified by your administrator.

Note:  If your email account was migrated from another email system,  
such as Microsoft® Outlook®, you may see extra folders that represent folders 
from the previous email system.
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Sharing Your Mail Folders

You can share any of your mail folders, including the Inbox folder and sub-
folders. You can share with internal users who can be given complete 
manager access to the folder or only the ability to view the folder.

When internal users share a mail folder, a copy of the shared folder is put in 
the Grantee's Folder list on the Overview pane. When the folder is selected, 
the content displays in the Content pane. You do not need to log on to the 
Grantor's mailbox. 

Scenarios for sharing a mail folder

• Your sales department wants one central mailbox for all email messages 
requesting information about your product, and everyone in sales should 
be able to view email messages immediately when they come in. You can 
give everyone in the department permission to view the mail folder and 
they can copy the messages to their mailbox, or you can give them 
permission to manage the mail folder and they can reply on behalf of this 
address. 

• A manager is often out of the office and does not have time to respond to 
her email messages. When the manager delegates access to her Inbox 
mail folder, her assistant (grantee) can manage the content of her mail, 
respond to messages on her behalf, create folders to organize message in 
that mail folder, and delete messages. 

• Instead of sending email messages to dozens of addresses every time you 
have an announcement, you can identify one of your folders as a public 
folder that contains the email announcements.  You can create shared 
access to only specific email addresses and set a password that must be 
entered to view the content, or you can make it a public URL for anyone 
who has the URL can view the content.  

To learn how to share your mail folders, see Chapter 15, Sharing Your 
Account Items.

Moving Email Messages

You can transfer email messages or entire conversations from one folder to 
another using one of two methods:

• Drag and drop the item to the desired folder in the left-hand Overview 
pane.
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• Select the item(s), right-click, and select . The Move Message 
dialog appears.

• Select a destination folder, and click OK.

If you are moving a few messages within a conversation, the conversation 
appears in both places. The Conversation Detail View window shows the new 
location of the message that was moved.

Sorting Messages in the Content Pane

Any pane containing email messages, such as your Inbox, can be sorted by 
the From, Subject, and Received columns. Sortable columns are highlighted 
as you pass your mouse cursor over them. 

To sort by a particular column, click the column title. The column shows an 
arrow indicating whether the sort is in ascending order (up arrow) or 
descending order (down arrow).

You can only sort by one column at a time.

Deleting a Message: The Trash Folder

When you delete a message, it is moved to the Trash folder. 

To recover a deleted message:

• Drag and drop the message from the Trash folder into another folder.
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In the example above, the message from Dan Demouser is being dragged 
from the Trash folder into the Inbox folder (highlighted in Folder pane).

Purging an Email Message from the Trash Folder

You can purge messages in Trash, which means the messages are 
permanently deleted and cannot be recovered.

To purge or delete messages from Trash:

• Right-click on the Trash folder and select Empty Trash. All messages are 
permanently deleted. 

Your administrator sets the policies for your site regarding how long messages 
remain in your folders before automatic purge occurs.

Managing Junk Email & Spam: The Junk Folder 

Most filtering of unsolicited automated email (also known as spam or junk 
mail) is handled by a spam filter before those email messages reach your 
Inbox. 

Email that might possibly be junk mail, but is not certain to be junk, is placed in 
your Junk folder. You can review these messages and either move them out 
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of the Junk folder or delete them. If you don't move or delete the messages, 
they are purged after a number of days as specified by your administrator.

Spam

If you find that you are receiving a large number of unwanted email messages, 
often referred to as spam, contact your administrator. Reporting email as 
spam helps your email administrator to fine-tune any spam filtering that may 
be in use at your site.

Marking an Email as Junk:

To mark an email as junk

1. Select the message in your Inbox.

2. Click  on the toolbar. 

The email is moved to your Junk folder. 

Sometimes messages may be put in the Junk folder that are not really junk 
mail. You can either:

• Drag the message(s) to another appropriate folder.

• Select the message(s) and click Not Junk on the toolbar. The selected 
message is moved to your Inbox.

To empty the Junk folder:

1. Right-clicking the Junk folder and select Empty Junk.
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The contents of the Junk folder are automatically purged after an 
administration-configured number of days. Contact your administrator to find 
out how often your messages are purged.

Setting Your Junk Mail Options

In addition to the automatic ZCS spam filtering rules, you can set up your mail 
preferences to identify specific addresses to block or not block in your 
mailbox. You create a list of addresses that should not be added to your Inbox 
and addresses that always should be added to your Inbox, but could be 
detected as spam. The spam filter uses this list to make sure you get the email 
you expect. 

• In the Block messages from section, specify email addresses from senders 
that should always be treated as junk.

• In the Allow messages from section, specify email addresses of people you 
trust so that their messages are not sent to your Junk folder. Messages 
from these email addresses are never blocked. You do not need to add all 
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your trusted addressed to this list. Add addresses to this list that for some 
reason end up in your Junk folder and you do not want them there, such as 
newsletters you subscribe to. 

How to set up your Junk Mail Options

1. Go to Preferences and select the Mail folder.

2. On the page that opens, scan to the Junk Mail Options section.

3. Enter complete email addresses in the appropriate boxes, either Block 
messages from or Allow messages from.  You can enter up to 100 
addresses for each.

4. Click Save on the toolbar
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This chapter explains how to:

• Compose a new email message

• Add attachments to messages

• Reply to email messages

• Forward email messages

• Configure optional email features

• Set up email signatures

• Set a forwarding address

Composing a New Email Message
The ZWC uses standard email functionality with several enhancements. Using 
the ZWC, you can take advantage of the following features:

• Use automatic address completion to complete addresses for you (from 
your Address Book contacts) as you type into the To, Cc, and Bcc fields. 

• Attach one of the many file types supported by the ZWC.

• Create custom signatures for use in your email messages.

To compose a new email message, either:

• Click  on the toolbar.

• Right-click on a sender (in the From column) in the Inbox, and select 

. 

A new Compose tab is created and a blank compose page opens. 
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Depending on your email preferences, the blank compose page opens in a 
new tab (as shown above) or opens as a separate compose window.

To complete the email:

1. Enter the email address of the person or persons to whom you are sending 
the message in the To and Cc fields. Either type the address into the field, 

or click  to search through your contacts or the global address 
list.

2. Add Bcc addresses (if necessary) by clicking Show BCC Field on the 
compose header. 

3. Enter the subject of the email in the  field.

4. Type the body of the email in the text area below the formatting icons.

From the compose toolbar:

1. Click  to check the spelling in the message. 

2. Click  to add an attachment. 

3. Click  and select Request Return Receipt, if you want to be 
notified if the message is opened. Note: The recipient must have Return 
Receipt enabled in their account before you will receive a notice.
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4. Click  to send the email.

5. Click  to save the message as a draft (to send later). The 
message is saved in the Drafts folder.

To retrieve a draft, open the Drafts folder and click on the message. You 
can compose and send the completed message as normal. When sent, the 
message is removed from the Drafts folder.

6. Click  to select a signature you have defined for use in this 
message. 

Creating signatures is covered in the Optional Email Features section.

Note:  If you have more than one email identity (also known as a persona) 
configured, an Account list will be displayed. Choose the identity to use for 
this message from this list. More information on email identities and personas 
is provided in Chapter 6, Customizing Your Email Features.

Note:  If you supply a first and last name that is not in the form of a valid 
Internet address (name@domain.com), a confirmation dialog appears 
advising you that the address does not appear to be valid. You can choose to 
send the email anyway, even though it may not be deliverable. 

Cc and Bcc Addresses

The abbreviations Cc and Bcc stand for Carbon Copy and Blind Carbon Copy, 
respectively.

• Cc. Lets you send a copy of a message to someone who's interested but is 
not the primary recipient. All Cc'ed recipients see the entire list of 
addressees when they read the message.

• Bcc. Lets you send a copy of an email message to someone without their 
address appearing in the copies of the message sent to other recipients.
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You can send a message without any addresses in the To field, as long as 
there is at least one address in either the Cc or Bcc fields.

Using HTML Editor

You can compose your messages using HTML as the rich-text editor. 
Messages created using HTML can have text formatting, numbering, bullets, 
colored background, tables, and links which can make messages easier to 
read. 

To quickly change the format for this message only:

• Click Options > Format As HTML to format your message with different 
font styles, tables, color, etc.

• Click Options > Format As Plain Text to produce text with no style or 
formatting.

You can set the HTML editor as your default editor and set the default font 
settings (including style, size and color) from the Preferences > Composing 
folder.

Note:  Some email clients may not accept messages formatted in HTML.

Using Spell Check

To check the spelling of your message:

1. Click  on the toolbar. Words in the email message that are 
unknown to the spell checker are highlighted.
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2. Right-click on a highlighted word. A drop-down menu displays suggested 
corrections.

3. Select the correct word. The word is highlighted in another color.

4. Click  at the top of the body to accept your changes and 
close the spell checker.

Note:  Before you close the spell checker you can change a corrected word 
back to the original spelling. Click on the highlighted word and select the initial 
spelling from the top of the pop-up.
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If you want to want to make spell check mandatory before a message is sent, 
enable Mandatory spellcheck before sending a message from your 
Preferences > Composing folder.

Adding an Attachment

Email messages can include attachments. You can attach documents, 
spreadsheets, pictures, slide shows, and other types of files.

To attach a file to a message:

1.  Compose the email message.

2. Click . The Attach File(s) dialog appears. 

3. If your account is configured with the Briefcase feature or a Flickr Photos 
account, the attachment page will include tabs. Select the tab where the 
attachment is saved.

4. Click  to locate the file. 

5. Select the file and click Open. The file name appears in the Attach File 1 
field.

6. Click  to attach another file.

7. Repeat steps 3 and 4 for each attachment.
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8. Click . The compose window appears with the attachment(s) in 
the header.

9. Click  to send the message and the attachment(s).

Note:  Recipients of your email message must have the appropriate software 
to open and read the file. For files created in commonly used packages such 
as Microsoft Office, other users on a typical desktop system will be able to 
open them. Common file formats, such as text files, HTML files, and images 
such as GIF or JPEG files, can be opened in a variety of programs.

Attachment File Types Supported

You can attach any file on your file system that you can find using .

You can open any file attachment directly from the ZWC, provided that you 
have the right application and the extension is not blocked by your 
administrator. For example, to open a document created using Microsoft 
Word, you must have Microsoft Word on your computer.

On most computers, the file type is indicated by the extension, which is usually 
a period followed by a three-letter code. Examples could include files such as 
expenses.xls or New-Items.doc. If the file type is one that is supported by 
the installed software on your computer, you can typically double-click the file 
and your computer will automatically launch the right application for reading 
that file.

Many types of files can be opened directly from your browser using various 
plug-ins. Usually, if you click a file link on a page, your browser automatically 
detects whether or not you have the right plug-in and prompts you to 
download it. Note that your system administration policies may not permit end 
users to download and install any sort of software.

On Windows computers, the computer assumes that the file type in the 
filename matches the actual format. Even if the file is correctly formatted 
internally, if it does not have the right file type extension in the filename, your 
computer may not be able to recognize it and open the right application.

An increasing number of computer viruses have been designed to spread via 
file attachments. Therefore, in some environments, system administrators 
have opted to block incoming email containing certain types of attachments, 
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most notably files with the extension .EXE or .ZIP as part of their filename. If 
you send an email message to someone whose email system has been 
configured to block certain types of attachments, you may not receive any 
notification if the email was blocked.

For your reference, here are some widely used file extensions:

File 
Extension Description

.txt

Indicates a text file, which is a file containing only text 
information. 

Text files can be opened and read using a wide variety of 
text editors, including Notepad, WordPad, Word, 
command-line editors, browsers, and even spreadsheet 
programs.

.htm
Indicates an HTML file, a special type of text file that is 
usually opened using a Web browser.

.zip

Indicates a file that has been compressed using ZIP 
compression. 

You will need WinZip or another compression program 
that can read and expand the ZIP file.

.exe
Indicates an executable or program file. 

Double-clicking or opening such a file usually launches 
the application.

.doc
Indicates a Microsoft Word document file, which can be 
opened with Microsoft Word or OpenOffice.

.jpg

Indicates a graphical image in the JPEG format. 

You can open JPEGs in a browser or by using one of a 
variety of graphics programs such as Paint or Adobe 
Photoshop.

.gif
Indicates a graphical image in the GIF format. 

You can open GIFs in a browser or with a graphics 
program.

.mpg
Indicates a movie clip or animation in the MPEG format. 

MPEGs are often playable with a browser plug-in or a 
player such as Windows Media Player.
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Requesting a Return Receipt

You can flag a message that you write to have a return receipt message sent 
back to you when the recipient opens your message. To request the return 
receipt, before you send the message, select Return Read Receipt from the 
Options menu. 

Even though you request a return receipt, the recipient can choose to return 
the read receipt or not. This is enabled in the Preferences > Mail folder.

Note:   The return read receipt flag does not work for messages that are sent 
to users on systems other than ZWC.

Automatic Address Completion
The auto complete feature suggests names as you type into the To, Cc, and 
Bcc fields in a new message. A list of possible addresses from your contacts 
list that start with the text you typed is displayed. 

As you continue to type into the To field, the list of matching addresses 
becomes smaller as fewer matches are available. The list disappears if there 
are no matches.

The autocomplete feature matches the text you type against the following:

• First name

• Last name

• Email address

For example, you want to send an email message to David Brinks, whose 
email address is dbrinks@acme.com. When you type D into the To field, a list 
appears showing all possible matches, with the matching portions highlighted. 
In this case, it might display:

• Dale Edwards <ded@acme.com>

• David Brinks <dbrinks@acme.com>

.wmv
Indicates a movie clip in the WMV format, which is a 
Windows-only format.

.pdf
Indicates a document in PDF format. 

You can typically open it from within your browser using 
an Adobe plug-in.
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• Erica Dodd <erica878@xyz.com>

As you type more characters into the To field, the list of matches grows 
smaller. To continue the previous example, when you type Da into the To field, 
the list would display:

• Dale Edwards <ded@acme.com>

• David Brinks <dbrinks@acme.com>

Using Autocomplete

When your text matches one or more of your contacts, the matches are 
displayed in a list below the field you are currently editing. By default, the first 
match will be highlighted.

Several keys you can type trigger special behavior. The mouse may also be 
used to select a match.

• The comma, semicolon, Return/Enter, and Tab keys all trigger completion. 
The text you have typed will be replaced by the currently selected match.

• ESC hides the list.

• The up and down arrow keys change the selection in the list. Moving the 
mouse cursor over the list also changes the selection.

• Clicking the mouse on a match selects it for completion.

To use a single key to quickly enter an address:

1. Type a few characters that will cause a certain contact to be the first match. 
For example, type s to cause <Sam Sample> to be the first match.

2. Press a quick key. For example, press Enter or the semicolon. The address 
appears.
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Saving Your Work
The Zimbra Web Client is a graphical user interface (GUI) that includes 
windows, buttons, and text entry fields.

With a GUI that uses Internet browser technology to display and operate the 
user features, it is not always possible for the application to detect when you 
have done something that you might want to save.

Within the ZWC, the following rules apply:

• If you are in the middle of composing an email message, and you click 
another portion of the Zimbra screen, you are prompted to save your work. 
You can subsequently find the message in your Drafts folder.

• Emails you are composing are periodically saved to your Drafts folder by 
default. Your administrator sets the frequency of the auto-saves.

Saving Messages You Send: The Sent Folder

By default, a copy of every email you send is saved in the Sent folder. You can 
delete email from the Sent folder at any time.

To change the default to not save a copy of messages you send:

1. Select the Preferences > Composing folder and go to the Save Messages 
section.

Select Do not save sent messages in the Sent Messages area.

2. Click .

Replying to an Email Message
You can reply to the sender of a message or you can reply to the sender and 
all recipients of the message.
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•  Click this button in the toolbar to open a new email compose 
window with the To field populated with the name of the person who sent 
you the original message.

•  Click this button in the toolbar to open a new email compose 
window with the To, Cc, and Bcc fields populated with the names of all 
recipients of the original message. Use this option if you want everyone 
who received the original message to receive your response.

Both options include the body of the original message in the reply. However, 
attachments from the original message are not included in the reply.

Depending on how you set your user preferences, the text from previous 
messages may have a character showing the number of previous exchanges 
that have occurred since this text was written. 

For example if the reply is part of an ongoing conversation, and you have the 
option Include original message with this prefix set to use the > character, 
the text from each part of the exchange is shown with angle brackets:

> Previous message

> > Message before previous message

> > > And so forth

Note:  If the message is in a conversation, changing the subject line will cause 
your reply to appear in a new conversation.

To reply to a message:

1. Select the email you want to reply to.

2. Click  or  in the control bar. A new compose window 
is displayed with the address(es) in the header and the original message in 
the body.

3. Type your reply.

4. Click  on the toolbar if you want to change how the original 
message is included in the reply. The options include:
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• Don’t Include Original Message

• Include Original As Attachment

• Include Original

• Include Original With Prefix

• Include Original with Headers and Prefix

• Include Last Message Only

• Your default option is marked but you can change it for this email only

5. Click .

Note:  If you add your signature automatically to your messages, your 
signature is automatically placed in the message according to the preference 
you enabled: either at the end of all messages in the compose window or at 
the end of the message you compose, above the quoted text.

Forwarding an Email Message
You can Forward an email message to someone else. Forwarding a message 
includes all file attachments, whereas Reply preserves the body text but does 
not include the attachments.

To forward a message

1. Select the email you want to forward.

2. Click  on the toolbar. A compose window opens. The text of the 
forwarded message appears in the body unless you have chosen to 
forward messages as attachments using the Preferences > Mail folder.

3. Enter addressees in the To, Cc, or Bcc fields.

4. Add a few lines of new text at the top of the message to let the recipient 
know why you decided to forward the message.

5. Click .
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You also have the Edit as New option where you can use the existing message 
as a template and send the message to the same user or a different user. To 
edit a message as new, right-click on the message and select Edit as New.

Optional Email Features
There are several optional email features available when using the ZWC. For 
example, you can:

• Create an email signature

• Forward your Zimbra email to another email address

• Customize your initial email page

Email Signatures

An email signature is closing text included at the end of an email. A signature 
can include your name and any additional text. If you format your signature 
with HTML, you can format your signature, add a link to a URL and add 
graphics to your signature. 

You can create more than one signature. For example you may want a formal 
signature for emails sent to customers and an informal signature for emails 
sent to friends. When you compose your message, you can pick the signature 
to use. 

If you create multiple email identities (also known as personas), you can 
create different signatures and assign them to specific addresses. More 
information on email identities and personas is provided in the Managing 
Email chapter.

To create a signature

1.  Use the Preferences > Signatures folder.
 48      



Composing and Sending Email           
2. In the Signature Name field, type a descriptive name to identify the 
signature. You can create multiple signatures so using an identifiable name 
here is important. When you compose an email, you can select the 
signature name to use.

3. Type the signature text exactly as you want it to appear in the text box. 

4.  Specify where you want your signature displayed in the Using Signatures 
section.

• Select Above included messages to add your signature at the end of 
the your composed, replied to, or forwarded text.

• Select Below included messages to add your signature at the end of 
the message.

•  Click Add Signature.

To apply this signature as the default signature for your account name

1.  Use the Preferences > Accounts folder.
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2. Select the signature name from the Signature drop down menu at the 
bottom of the screen.

Undeliverable Email

Sometimes a message bounces, meaning it cannot be delivered for a reason 
such as:

• Recipient is not a valid or existing email address. Verify that you have the 
correct email address.

• Recipient's email system rejects the email for one reason or another.

• Recipient's mailbox is full.

If a message is rejected, you will receive an undeliverable mail message that 
includes:

• At least part of the contents of your original message.

• Some system-generated error messages that provide more information as 
to why the email has bounced.

Try to correct the problem and re-send the email.

If the email bounces due to a bad email address, but you are certain that the 
address is valid:

• Contact the recipients using other means.

• Have the recipients resolve the issue with their system administrators.

Contact your administrator if:

• Every email message you try to send is rejected.

• Email bounces with user unknown or bad address messages for 
addresses that you used from your corporate address list.

• You start receiving bounce messages for email you did not send.

Setting a Forwarding Address

You can identify an email address to forward your messages to and choose to 
retain the message in your mailbox or automatically delete the message when 
forwarded.
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To forward your email

1. Use the Preferences > Mail folder. Scroll down to the Receiving 
Messages section.

2. Type a complete forwarding address in the When a message arrives: 
Forward a copy to field.

3. If you want to automatically delete the email from your account, enable 
Don't keep a local copy of messages.

4. Click . 
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4      Using Tags and Folders to Organize Your Mailbox
This chapter explains how to:

• Create and use tags

• Flag email messages

• Use folders

• Create custom folders

Working with Tags
Tags are your personal classification system for email messages, contacts, 
tasks, and appointments. Using tags is an aid for finding items. For example, 
you might have one tag for Immediate Turnaround and another for Medium 
Priority. 

Some of the advantages of tags include:

• You can sort email using tags.

• You can search for a tag and all messages with that tag will be displayed, 
no matter what folder they are in.

• You can create as many tags as you want.

• You can apply multiple tags to the same email message and contacts.

Creating Tags

You can create a New Tag using any of the following:

1. Right-click Tags in the Overview pane, and select New Tag.

2. Select a message, click  in the toolbar, and select New Tag.
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3. Right-click an item in a list view, choose Tag Message, and select New 
Tag.

4. Right-click on Tags or a tag in the Overview pane and choose New Tag.

To create a new tag

1. Select New Tag. The Create New Tag dialog is displayed.
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2. Type a name for the tag in the Tag name field, and choose a tag color from 
the drop-down menu.

3. Click .

Tag names can have any character except the following

• : (colon)

• / (forward slash)

• " (double quotes)

The new tag is listed under Tags in the Overview pane and can be applied 
to any email messages or contacts.

You can assign multiple tags to a message. If a message has multiple tags, 
they are layered and multi-colored.
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Assigning a Tag to Messages and Other Items

Tagging is similar to flagging, except that you can create and apply multiple 
tags to a single item to classify it under several categories simultaneously. 
After you create a tag, you can apply it to conversations, messages, or 
contacts.

To tag an item using drag and drop:

Drag and drop the tag from the left-hand Overview pane onto the item on the 
Content pane.

To apply a tag to an item using menus

1. Right-click the item from the Content pane. 

2. Choose Tag Message (or Tag Conversation, Tag Contact, etc.).

3. Choose the tag name from the list that appears. Only tags not already 
applied to the selected item are listed.
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To remove a tag from an item

1. Right-click the item from the list and choose Remove Tag.
 

2. Select the tag you want to remove, or choose All Tags to remove all tags at 
once.

To apply/remove a tag to multiple items at once

1. Select all the items to be tagged using Control-Click or Shift-Click.

2. Right-click over any one of the selected items, and choose an existing tag, 
New Tag, or Remove Tag.

To find tagged messages quickly:

• Click a tag in the Overview pane.

All messages with the selected tag are displayed in the Overview pane. In the 
example below, all messages with the Demo tag are displayed.
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To search for tags, type one of the following into the Search field:

• tag: <"tag name">. Displays all tags with this name.

• tag: "color". Displays all tags with this color.

Deleting a Tag

To delete a tag

1. Right-click the tag name on the Overview pane.

2. Click Delete.

Deleting a tag removes the tag from any item that had that tag. The items 
themselves are not deleted.

Flagging an Email Message
The flag icon in the message list is a yes/no indicator that denotes whether the 
email message has been flagged. This can be used to indicate an action-
needed item or to distinguish the message or conversation from other items of 
lesser importance.

To turn the flag on

1. Place your cursor over the flag column for the message or conversation. 
The flag icon appears in a shadowed form.
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2. Click once directly over the flag icon. The flag icon appears in its active 
form.

To turn the flag off

• Click on an active flag.

Using Folders: General Techniques
There are two types of folders in the ZWC: 

• System folders. System folders cannot be moved, renamed, or deleted. 
Examples include the Inbox, Sent, and Trash folders.

• User-defined folders. You can create folders to organize your email. 
Folders you create are displayed in the Folders list in the Overview pane. 
Top level folder names must be unique. The name cannot be the same as 
any other top-level folder in your email, calendar, or address book folders.

Creating a Custom Folder

Custom folders can be created inside other folders, including system folders. 

You cannot create two folders with the same name within the same parent 
folder. For example, you cannot have two folders named Shopping inside 
your Inbox folder, but you could have one folder named Shopping inside your 
Inbox folder, and another one with the same name inside the Sent folder.

To create a new folder, either

1. Click  at the top of the Overview pane, or 

Right-click in the Overview pane in the folders list, and select New Folder.
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A Create New Folder dialog appears.

2. Type the folder name into the Name field. 

Select where to place the new folder. Either:

• Click Folders to have the new folder displayed at the top of the list.

• Click an existing folder to place your new folder within that folder.

3. Click .

Renaming a Folder

To rename a user-defined folder

1. Right-click on the folder, and choose Rename Folder. 
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A Rename Folder dialog appears.

2. Type the new name for the folder into the New name field.

3. Click .

Folder names can have any character except:

• : (colon)

• / (forward slash)

• " (double quotes)

Deleting a Folder

To delete a user-defined folder, either

1. Drag the folder to the Trash.
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In this example, the Zach’s Forum Posts folder is being dragged to the 
Trash.

2. Right-click the folder, and choose Delete.

When you delete a folder, its contents are moved to the Trash. You can 
recover contents from the Trash by dragging and dropping them to another 
folder. 

If you want to save some of the messages in a folder before you delete the 
folder, move the messages to another folder.

Note:   The Trash folder is purged on a regular basis, which is set by your 
administrator, so items in the Trash do not stay there forever.
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5      Create Filters to Automate Email Handling
This chapter explains how to:

• Create filters

• Understand the conditions and actions of a filter

• Use wildcards when creating filters

Email filtering allows you to define rules to manage incoming email, including 
Calendar-related messages. Filtering applies a set of rules to incoming email 
and then executes a specified action. You can filter your incoming email 
messages to:

• Sort them into folders

• Automatically tag them

• Forward them

• Discard them 

For example, you could create rules as follows:

• All email from your supervisor goes into your Management Directives 
folder.

• All email from the corporate-events mailing list is tagged with the Events 
tag.

• All email from a specific address goes into the Trash folder.

Filter Conditions and Actions
Each filter rule consists of one or more conditions and one or more actions. 

Conditions

For example, if your supervisor sends you emails from more than one 
address, such as jane.smith@company.com or jane-smith23@yahoo.com, 
you could create one filter called Supervisor which has two conditions, one 
for each email address.
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Conditions may include:

• Specific addresses in the From, To, Cc addresses in the email header

• Email messages that are under or over a specific size. Size can be 
specified as B, KB, or MB

• Date is before or after a specified date

• The presence or absence of file attachments

• Addresses that are or are not in your Address Book.

• Words or character strings in the subject or body of the email message

• Whether a message is a calendar invite

All the conditions allow you to specify not as a negative condition. For 
example, you can specify email that does not contain a particular word.

You can combine conditions to search for email with more complex 
characteristics.

Actions

Each filter rule can specify one or more actions. Actions include:

• Leave the message in the Inbox (no action)

• Move the message to another specified folder

• Tag the message

• Mark the message as read or as flagged

• Discard the message. This action drops the email message silently, which 
means that the message does not reach your mailbox. It is not the same as 
the Delete action on your menu. Deleting an item moves it to the Trash 
folder.

• Forward the message to a specified email address

Note:  Check Do not process additional filters  to prevent the application of 
any other filter rules to email messages that match this current rule. If it is not 
checked, subsequent filter rules are evaluated for the email message even if 
the current filter is a match. You probably don’t want to have the same 
message match more than one filter rule and undergo multiple, perhaps 
contradictory actions.
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Using Any and All
Conditions within a filter rule can be grouped using Any or All. The use of 
these terms is similar to And versus Or type searches, with Any being Or and 
All being And.

• Any. A message that meets any one of the conditions is considered a 
match.

• All. Every condition specified in that filter rule must match in order for that 
message to match the filter.

When Filters are Used
All filters currently defined are listed on the Preferences > Mail > Filter page. 
The Active check box allows you to turn filters on or off without having to 
delete the filter rules.

Each incoming message is tested against your active filter rules when it is 
delivered, and the filter actions are applied to matching messages at that time. 

Filter Order

Filters are applied in the order they are listed on the Mail > Filters page. You 

can change that order at any time using  and . 

The conditions are used to test each email message. If the message meets 
the conditions collectively (using the Any or All designation as specified in the 
filter rule), it is a match. The order of the conditions within each filter is not 
important.

If the message matches the conditions, all actions associated with that filter 
rule are applied, in the order in which they appear in the filter.

Creating a Filter
You can create a filter in two ways:

• Using the Preferences > Mail > Filters page.
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• Using a message in the Inbox

Creating a Filter from the Mail Filters folder

1. Select the Preferences > Mail > Filters page.

2. Click . The Add Filter dialog displays. 

3. Type the name for the rule into the Filter Name field.

4. In the If the following conditions are met area, choose a grouping 
preference. 

 

• Any means that if any of the conditions in the filter are met, apply the 
action. 

• All means that all of the conditions in the filter must be met to apply the 
filter action. 
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Steps 5-11 can be repeated to set up multiple conditions and actions within a 
single filter:

5. Select from the first drop-down list which part of the email to filter. For 
example, choose an email field, a portion of an email message, or an email 
address. 

In the above example, Subject is selected. Therefore, the Subject of all 
incoming emails will be filtered.

6. Choose a comparison method. The options shown depend on your choice 
in the previous step.

In the above example, contains is selected. Therefore, the filter will look for 
Subjects that contain certain text.

7. Enter a word or phrase to compare against in the text field. For example, 
enter Staff Meeting to filter all messages containing Staff Meeting in the 
Subject.
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8. Click  to add more conditions, if needed. You can continue to add 
more conditions or proceed to add one or more actions.

9. Choose an action from the drop-down list in the Perform the following 
actions area.

In the above example, Tag with is selected. Therefore, the filter will tag 
email messages with a Subject containing Staff Meeting.

10.Specify a folder or tag name, if necessary. What you specify depends on 
the action you chose in the previous step.
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In the above example, the Meeting tag is selected. Therefore, all incoming 
email messages that have a Subject containing Staff Meeting will be 
tagged with the Meeting tag.

11.If not already checked, check  (upper right corner of Add Filter 
box) to turn on the filter rule. 

12.Click  to add more actions or click  to finish. 

The filter will be applied automatically to all new incoming email messages as 
they arrive.

Creating a Filter from an Email Message

To create a new filter from an email message:

1. Right-click on the message and choose New Filter. 

2. The Edit Filter dialog displays with From, To, and Subject set with this 
information from the email message.
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3. If the filter conditions are correct, enter a name in the Filter Name field and 

click . 

You can change the conditions and actions as necessary using the drop down 
menus in the Edit Filter dialog.

Editing a Filter
To edit a filter:

1. Select the Preferences > Mail > Filters page.

2. Click . The Edit Filter dialog displays.
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3. Use the drop-down menus and fields to edit the filter as necessary.

4. Click .

Run a Filter Over Existing Content
You can run filter rules over existing mail. In the Preference > Mail > Filters 
page click Run Filter and in the Choose Folder dialog, select the folders to 
apply the filter.

Filter Conditions and Actions Supported
This section describes the conditions and actions supported by ZWC filters. 
Filter rules are not case-sensitive, so the rules ignore capitalization.

Conditions

Comparison fields include those in the following table.

Comparison 
Field Description
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From Use this to specify a From name in an email message.

To
Same as From, but looks for specified names in the To 
header.

CC Same as From, but looks in the Cc header.

Subject Looks in the message's Subject header.

Header Named

When this option is selected, an additional text input field 
appears before the comparison operator (the contains 
portion). This option allows you to specify any email 
header. You can specify the standard fields of To or 
From and Date, Reply-To, or other custom fields that 
may be included in the message header. 

You could use this option to filter out email messages 
that have malformed headers, meaning they do not 
contain certain information that is normally considered 
standard for an email message. Sometimes spam, 
which is automatically generated, omits information such 
as the Sender or Reply-To fields. Use the second text 
field (the field immediately to the right of the comparison 
operator) to specify the header to test for.

Size

Use this to select email messages that are larger or 
smaller than a specified size, including any file 
attachments. You can use this to discard email 
messages that are too large.

Date
Use this option to specify email messages sent before or 
after a specified date. 

Body

The options for Body are Contains and Does not 
contain. This allows you to specify matching words in the 
body of the email. You cannot filter for words in file 
attachments.

Attachments
You can filter for email messages with or without 
attachments.

Address In
Tests for an address in your contacts and allows you to 
specify an address field such as From.

Calendar Invite Use to filter for messages that are Calendar invitations. 
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Comparison operators include those in the following table.

Comparison Operator Description

Matches exactly/does not match 
exactly

Specifies an exact match. 

For example, specifying Subject 
matches exactly Banana would only 
match Banana and not Bananas or A 
truck full of banana leaves.

Contains/does not contain Specifies that the subject line must 
contain the specified substring.

For example, specifying Subject 
contains Banana would match I'm 
going bananas.

Matches wildcard condition/does 
not match wildcard condition

Specifies that the subject must match 
the specified string, which includes 
wildcards. 

For example, specifying bana* would 
match banana and banana tree but 
not free bananas.

The wildcard * is a character used in 
the email filter comparison field to 
represent one or more characters in 
the filter.

Exists/does not exist Matches if the specified field is present 
in the message. Used with the Header 
Named and Attachment fields.

Under/not under, over/not over Used for comparison against the Size 
field.

Before/not before, after/not after Used for comparison against the Date 
field.

In/not in Used to test for presence of an 
address in your contacts.

Actions

Available actions include those in the following table.
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Action Description

Keep in Inbox
Saves email to Inbox. If none of the filter rules match 
an email message, this action takes place by default.

File into Folder Moves the email to a specified folder.

Discard
Deletes the email message without delivering it. The 
message is not in any of your folders, not even 
Trash.

Forward To Forwards email to the address you specify.

Mark Select as Read or as Flagged.

Tag with You can tag matching messages with a selected tag.

Multiple Actions

A filter rule can specify multiple actions. The combinations of actions are 
interpreted as described in the following table.

Multiple 
Action Description

Discard
If combined with other actions, discard is ignored and the 
other actions take place.

File into 
folder

Multiple file into actions results in multiple copies of the 
message being stored in different folders. If a specified 
folder does not exist, the message is saved to the Inbox.

Tag/Mark

These actions apply to the message returned from the 
nearest preceding action. In the case of multiple file into 
actions, this could result in some copies of the message 
stored without a tag, and others stored with a tag.

Keep in Inbox
Multiple keep actions can be specified, but only one copy 
of the message is saved to the Inbox.

Filter Wildcards
Wildcards can be used in comparisons that use the Matches pattern 
comparison operator. The two wildcard characters are * and ?
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Asterisk (*)

The asterisk is a placeholder for zero or more characters of any type.

Example Match

Subject-line search string: 
banana*float

Subject lines such as bananafloat, 
bananas, banana-leaf casserole float but 
not super-banana-float

Subject-line search string: 
w*bandanna

Subject lines such as white bandanna or 
whose bandanna but not whose bandanna 
is this?

Question Mark (?)

The question mark is a placeholder for exactly one character.

Example Match

Subject-line search string: banana?boat Subject lines such as 
bananasboat, banana-boat, 
banana!boat, or banana boat

Slash (\)

There may be times that you want to specify an exact match on a string that 
contains characters that normally are considered wildcards. 

For example, you might want to specify a match on a subject line where the 
main heading is surrounded on both sides by three asterisks, such as:

• ***MORE MONEY!!!***

• ***FREE GIFT***

To specify a wildcard as itself rather than a substitution for other characters, 
use the backslash \ immediately before the character. For example the 
comparison string \*\*\**\*\*\* specifies a subject with three asterisks before 
and after any string in the middle (including spaces).
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6      Customizing Your Email Features
This chapter explains how to:

• Set up new mail notification

• Create away messages

• Manage your account identities

• Change your default time zone

The ZWC offers several email features that you may choose to use when 
managing your mailbox. The advanced email features include:

• New Email Notifications. Send email to another email address to notify 
you when you receive email in your Zimbra mailbox.

• Away Messages. Send out-of-office auto-reply messages when you are 
away.

• Personas/Other Email Identities. Create separate email identities, also 
called personas, to manage different types of email. For example, you can 
create a business persona for your business email and a personal persona 
for your personal email.

• External Accounts. Configure your Zimbra mailbox to check email at other 
external email addresses.

• RSS Feeds. Create a folder to receive RSS (Really Simple Syndication) 
feeds directly into your Zimbra mailbox.

• Mailbox Quotas. Manage the size of your Zimbra mailbox, so you do not 
exceed your quota.

Setting a New Email Notification
You can configure your email options to notify you at another email address 
when you receive email to your Zimbra mailbox. This feature may be useful if 
you do not receive a lot of email to your Zimbra account, but when you do 
receive email, it's important enough to require a timely response.
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To set notification

1. Select the Preferences > Mail folder, and scroll to the Receiving 
Messages area.

Check Send a notification message to.

2. Enter the email address.

3. Click .

Creating an Away Message
This feature is also known as an out-of-office auto-reply message. 

• You can set an away message that automatically replies to people who 
send you messages when you are out of the office for an extended period 
of time. 

• The auto-reply message is sent to each recipient only once, regardless of 
how many messages that person sends you during the designated 
vacation period.

• You can set up the out-of-office reply in advance and set a date when the 
message should begin to be sent and when the message should stop.

To set an away message

1. Select the Preferences > Mail folder, and scroll to the Receiving 
Messages area.
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2. Check Send auto-reply message.

3. Enter the message to be sent in the text box, such as the message shown 
above.

4. Enter a date when the message should begin to be sent and a date when 
the message is not longer necessary.

5. Click .

Managing Your Account Identities
There are two different aspects to account identities in ZWC:

• Account identities. These are also known as personas, within your 
Zimbra account

• External accounts. These are other email accounts you may have 
besides your Zimbra account

When you send new email or reply to or forward an email message, one 
identity is always associated with the email. This is the default identity or 
persona created as your account name and is used unless you set up different 
identities.

Creating different account identities, called personas, allows you to use 
multiple email addresses from your mailbox. You might want to do this to 
manage different roles in your job and personal life from this single email 
account. 

You can also add external account addresses to your Zimbra account to 
retrieve email from your other POP accounts. You can configure the external 
account settings so that when you reply to those messages, a specific address 
is shown in the From field.
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If you have set up more than one persona or added external accounts, when 
you open a new compose window, your identities are listed in the Account 
field in the header. 

Creating a Persona
Creating different personas allows you to use multiple email addresses from 
your mailbox. For example, you could use your default persona for your 
business email correspondence and you can create a new persona for your 
personal email correspondence.

To create a persona

1. Select the Preferences > Accounts folder. Your default account 
information is shown at the top of the tab.

2. Click . A new account name appears, and the Persona 
Settings area appears.
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3. Complete the fields in the Persona Settings area, as shown on the next 
page.

4. Click  on the toolbar to save your new persona.

Complete the fields in the Persona Settings area, as shown in this 
example where a Training Persona is created to manage all emails related 
to training.

5. Enter a name for this persona in the Persona Name field. This is the name 
used to identify the persona in the From list when you are composing an 
email. It does not appear in the email message.

6. Specify the From information for this persona:

• Type the name that should appear in the From field of your outgoing 
email messages. This is the friendly name that is shown before your 
email address.

• Select the email address from which to send messages into the second 
field. If this field is not editable, you do not have additional external 
accounts identified.

7. To direct replies to emails from this persona to a name and address 
different from that which you configured in From.

• Check Set the “Reply-to  field of email  messages to. 
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• Enter the name and address that should receive replies for this identity. 
For example, replies to training messages should be sent to Team 
Training at training@yahoo.com. 

8. Select a signature for this persona using the Signature drop-down menu.

• If you have not created the signature, you can come back and edit this 
persona later.

• If you do not want the signature to be applied automatically, select Do 
Not Attach Signature from the menu.

9. To automatically use this persona when replying to messages sent to a 
specific email address, or when forwarding messages from that address:

• Check When replying or forwarding messages sent to.

• Type the email address(es) in the field. If you are entering more than 
one email address, separate addresses with either a comma or a semi-
colon.

10.To automatically use this persona when replying to messages in a specific 
folder, or when forwarding messages from this folder:

• Check Replying to or forwarding messages in folder(s).

• Click the folder icon to select one or more folders from the list of existing 
folders or to create a new folder. 

• If you are selecting more than one folder, separate the folder names with 
either a comma or a semi-colon.

To create a signature for use with this persona, use the Preferences > 
Signature folder. Refer to Email Signatures in Chapter 3 for instructions on 
creating email signatures.

Retrieving Email from an External Account
Using ZWC, you can link your external email accounts to your Zimbra mailbox. 
Then, you can retrieve email from your external account(s) in your ZWC, 
instead of logging into each external account separately.

When you set up your external account on ZWC, you can:

• Specify where the messages will be saved
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• Create a persona to be used when you reply to or forward a message 
received from that external account

Information You Need

When you set up your external account you need to know the following details. 
You may need to contact your email provider for this information.

• Account type. This is the type of email you service provider uses: POP or 
IMAP.

• User name on the account. This is the user name associated with this 
email account. Sometimes your user name is the part of your email 
address before the @ and other times it is your full email address.

• Email server. This is the server name for your external account.

• Advanced settings. Your provider should let you know if they do not use a 
standard IMAP (143) or POP (110) port. Enable Use an encrypted 
connection (SSL) when accessing this server when you need to 
connect securely to the external server. The port numbers will change.

Receiving Messages from Your External Account

When you retrieve your external email messages, the messages and 
attachments are saved to the folder you specify when you configure your 
account information.

Messages from your external account(s) are not automatically received in your 
Zimbra Web Client account. To check for email from your external account(s):

• If you configured the Inbox to be the folder to save the external account's 

messages, click  on the toolbar. Your Inbox folder is updated with 
all new messages including messages from your external accounts.

• If you configured another folder for your external accounts, select that 

folder and click the  button on the toolbar. Messages are delivered 
to your folder.

• If you configured another folder for your external accounts, right-click the 
folder. The menu has a Get External Mail option. Select this option to 
receive messages.
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Adding an External Account

To add an external account to your ZWC account

1. Select the Preferences > Accounts folder. Your default account and 
persona information is shown at the top of the tab. In this example, a 
persona has already been created.

2. Click . A new external account name is added to your 
accounts, and the External Accounts Settings area appears.

3. Complete the fields in the External Accounts Settings area, as shown on 
the next page.

4. Click  on the toolbar to save the external account settings.
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5. Enter the exact email address of the external account in the Email 
Address field.

6. Enter a name to identify this account into Account Name field in the 
External Account Settings section. You can select this account name 
from the From address list when you compose new email messages. 

7. Check the Account type: POP or IMAP.

8. Enter the name of this email account into the Username of Account field. 

9. Enter the email server host name into the Email server field. 

10.Enter the password you use to log on to this external account in the 
Password field. To see that the password you typed is correct, check 
Show password.

11.If you service provider uses a different port than the default, change it in the 
Advanced Settings area. If you use a secure connection, enable Use an 
encrypted connection (SSL) when accessing this server.

12.Select where the messages should be saved using the Download 
messages to section. The default is to create a new folder and enable it to 
receive the messages.  But if you want the messages in your Inbox, select 
Inbox.
       85



Zimbra Web Client User Guide
13.Enable Delete messages on the server after downloading them if you 
want the message deleted from your external account when it is sent to 
your ZWC account.

14.Type the name that should appear in the From field of your outgoing email 
messages (for example, John). This is the friendly name that is shown 
before your email address. 

15.Check Reply-to if replies should be sent to a name and address different 
from that which you configured in From. Enter the name and address that 
should receive replies for this identity. For example, replies to training 
messages sent by John should be sent to Team Training at 
training@example.com. 

16.Select a signature for this external account using the Signature drop-down 
menu.

• If you have not created the signature, you can come back and edit this 
external account later.

• If you do not want the signature to be applied automatically, select Do 
Not Attach Signature from the menu.

17.Click  on the toolbar to save your new external account settings.

To create a signature for use with this external account, use the Preferences 
> Signature folder. Refer to Email Signatures in Chapter 3 for instructions on 
creating email signatures.

Subscribe to an RSS
You can subscribe to Web sites that provide your favorite RSS (Really Simple 
Syndication) and podcast feeds to send updated information directly to your 
mailbox. 

You need to know the URL for the RSS before proceeding.

To subscribe to an RSS feed

1. Click  above the Folders heading in the Overview pane. You 
must create a separate folder for each RSS feed.
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The Create New Folder dialog appears.

2. Type the name of the RSS feed folder in the Name field.

3. Check Subscribe to RSS/ATOM feed. The URL field is displayed in the 
dialog.
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4. Enter the URL for the feed in the URL field.

5. Select where to add the RSS feed folder in the folder menu. If you choose 
the root folder, the new folder is displayed at the highest level in your folder 
view, which is the same level as your Inbox folder.

6. Click .  The new folder, with the RSS feed icon , displays as the 
folder in your Overview pane. The feed is automatically sent to the folder in 
your Zimbra mailbox.

7. Open the RSS folder. The content is displayed in the Content pane.
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8. Click  in the toolbar to update the content.

Mailbox Quotas
To keep disk and resource usage to a manageable level, your administrator 
may enforce quotas to limit the amount of disk space your mailbox can 
consume. 

The display banner under your name in the shows a bar showing how much of 
your quota you have used.

If you are over quota, the following things may happen:

• You receive an email notification.

• Your email interface displays a notification when you log in.

• Email sent to you may be returned (bounced) to the sender, along with a 
notification that your mailbox is full.

To reduce the size of your mailbox:

• Delete old messages that are no longer needed. 

• Delete large file attachments to messages. Save the file attachments 
locally if you want to preserve them.

• Delete Documents notebooks, pages, images, Briefcase items that are no 
longer needed.

Note:  If you save attachments you receive to a Briefcase folder, this is a 
copy of the attachment. You can delete the attachment from the email.
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In all cases, remember to empty the Trash folder. 

Zimbra also supports automatic purging of messages that are over a certain 
number of days old. Your administrator sets the policy for when messages are 
purged, how old they have to be, and which folders are purged.

Changing Your Default Time Zone
Change the default time zone for your mailbox using the Login Options area 
of the Preferences > General folder. 

Note:  The default time zone setting that is displayed is used to localize the 
time for received messages and calendar activities in the standard web client. 
The advanced web client uses the time zone setting on the computer as the 
time stamp for received messages and calendar activities, not the time zone 
setting in the General folder. 
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This chapter explains how to:

• View your address books

• Add new contacts to specific address books

• Add names to email from your address books

• Add contacts automatically to your address books

• Create group contact lists

• Import or export your address book

Your email administrator can set a maximum limit for the number of entries 
you can have in all of your address books. When you reach this maximum, 
you cannot add any more contacts. However, you can delete unused contacts 
to free up space.

When you compose an email, the auto-complete feature displays a list of 
names from your address books that match the text you are typing. 

Note:  The Emailed Contacts address book is populated automatically when 
you send an email to a new address that is not in one of your other address 
books. You can disable this feature by removing the check from Enable auto 
adding of contacts on the Preferences > Address Book tab.

Viewing Contacts in Your Address Book
You can view the contact names in a list or as detailed cards.

• The Contact List view is a vertical list of all of your contacts. 
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• The Detailed Cards view shows all the information you entered on the 
contact form. 

To change the view for one session, use the View drop-down menu on the 
toolbar. 

To change the default view for Address Books

1. Select the Preferences > Address Book tab.

2. Select an option from the Default View drop-down menu in the Options 
area.
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When you pass your mouse cursor over an address, a tool tip displays the full 
email address associated with that name. If the name is already in an address 
book, both contact information is displayed. If the name is not in one of your 
address books, only the email address is displayed.

 

Adding a New Contact
You can add a new contact in several ways:

• Using  drop-down list on the Mail toolbar.

• Using  on the Address Book toolbar. 

• Right-clicking a name in a message header and choosing Contacts.

When you add a new contact, you:

• Enter the name, phone, and company information

• Select how you want to file the contact in your list

• Enter contact information including multiple email addresses, up to three 
mailing addresses, and other information. 
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Adding  a new contact from the toolbar

1. Click the arrow next to  on the toolbar, and select New Contact. 

The New Contact form opens.

2. Enter the contact information and upload a photo of this contact, if desired

The  sign represents fields that have more than one entry and can be 
identified with a specific label. For instance the phone number can be 
labeled as Mobile, Work, Home, Fax, etc.
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The field marked Other allows you to enter a custom field. Two custom 
fields are identified, Birthday and Anniversary. You can create additional 
custom fields. 

Click  and select Custom to add a custom field.

Change Custom to a name of your choice and enter the information in the 
Enter text box.

3. Select the following (optional):

• File As, to select how you want to file the name. The default is to file the 
contact by last name, first name. 

• Location, to select the address book to which you want to save the 
name.

4. . Click  on the toolbar. 

Adding a new contact from an existing email message

1. Open the email message, the header is displayed at the top of the 
message. You can add email addresses from the Sent By, To, Cc, and 
Bcc fields.

2. Right-click the name to add to your contact list and choose Add to 
Contacts.
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3. The New Contact form opens pre-populated with whatever information 
was available from the email header. Add additional information and check 
the pre-populated fields for accuracy.

4. Select the following:

• With File As, select how you want to file the name. The default is to file 
the contact by last name, first name. 

• With Location, select the address book to which you want to save the 
name.

5. Click  on the toolbar. 

Adding Names to Email from an Address Book
When composing an email, you can select email addresses from your address 
books. 

Company Address Book

Within your organization, you may not always know the correct email address 
to use. For example Joe Smith at Acme could variously be joe@acme.com, 
jsmith@acme.com, or js123@sales.acme.com. 

A company address book (also known as a Global Address List), is usually 
available to everyone in the company to help identify email addresses.

To add names from an address book to a new email message

1. Click  on the toolbar to open a new message.

2. Click To. An address selection dialog appears. Complete the remaining 
steps as described on the next page.
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3. Select an address book from the Show names from list. In the example 
above, Contacts is selected. The graphic below shows some options in 
this menu.

4. Enter a name or portion of a name in the Search field on the left.

5. Click Search. A list of names and email addresses appears on the left. In 
this example, Sam Sample is displayed because it matches the sa entered 
into the Search field.

6. Select a name to add it to the recipients list on the right.

7. Click the To, Cc, and Bcc buttons to determine where the name will appear 
when the message is addressed. Click the desired button before moving 
the name across. Use the Remove button to remove a name from the 
recipients list on the right.

8. Repeat the search as needed until all names have been added.

9. Click  .
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Adding Contacts Automatically
Using the Preferences > Address Book tab, you can select the Add new 
contacts to “Emailed Contacts” option to automatically add email 
addresses from your email messages to your Emailed Contacts list. With this 
feature enabled, any time you respond to a message that includes an email 
not in your address books, the address is automatically added to your Emailed 
Contacts address book.

The Email Contact address book lets you keep a separate miscellaneous 
address book from other address books with random addresses.

Creating a Group Contact List
The Group Contacts feature allows you to create contact lists, also known as 
email aliases, that contain multiple mailing addresses. When you select a 
group contact name, everyone whose address is included in the group list is 
automatically added to the address field of the message.

Note:  The icon   indicates that a contact name is a group contact.

To create a group contact list

1. Click the arrow on the toolbar and select Contact Group. 

The New Contact Group form is displayed.
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2. Type the name for this Contact Group into the Group Name field.

3. Select the address book to which you want to add this Contact Group from 
the Address Book drop-down menu. 

4. To add members to this group:

• Type a name into the Find field.

• Select the address book you want to search using the in drop-down list.

Names that match your entry are listed in the box below the Find field. 

5. Select the names to enter and click Add or Add All. The names are added 
to the Group Members list. 

6. You can also type email addresses directly in the Group Members list box. 
Separate addresses with either a comma (,) or a semicolon (;), or using 
Return. 

7. Click  on the toolbar. The new group contact is added to your 
address book.

Importing an Address Book
You can import contact lists and address books that are saved in a comma-
separated (.csv) text file format.
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To import an address book

1. Select the Preferences and click Import / Export.

2. In the Import section, select the type as Contacts.

3. Select the type of .csv contact file you are importing from the drop down list 
next to Contacts. Picking the correct type of contact file identifies the order 
of the fields so that the information displays correctly in your Address Book

4. For the Destination, select the address book to import into or create a new 
address book.

5. In the File field, click Browse to locate the .csv file to import. 

6. Click Import . 

Depending on the size of the .csv file, import may take a few minutes. When 
the import is complete, the Status Box shows the number of contacts 
successfully imported. Contacts are alphabetized by last name.  

Exporting an Address Book
Your address books are exported and saved in a comma-separated (.csv) text 
file format. 

To export an address book

1. Select Preferences, and click Import / Export 

2. In the Export section, select the type as Contacts.
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3. In the Source area, select the contacts to export

4. Click Export. An Opening Contacts.csv dialog appears.

5. Check Save to disk and click OK. 

Printing a Contact Name or Address Book
You can print a complete address book or just print the information for one 
contact.

To print from address books

1. Select an Address Book

2. To print, either:

• Select a specific contact name and click the Print icon .

• Click the arrow next to the print icon and select Print Address Book. 

Note:  For Group Contact lists, if the list is long, only the first few names on 
the list are printed and More... displays, to let you know that there are 
additional names that were not printed.

Editing Contact Information
To open a contact for editing
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1. In Address Book, select the contact to edit and click .

2. In the Edit Contact form, make any changes.

3. Click  to commit your changes.

To move a contact to another address book

1. From the Contacts area, right-click the contact to be modified and choose 
Edit Contact.

2. Select the address book where you want to move the contact using the 
Address Book drop-down menu.

3. Click . 

Deleting Contacts
Any contact lists you create can be deleted. Contacts can be deleted in one of 
three ways:

• From an address book, select the contact to be removed, and click 

 on the toolbar.

• Drag the contact name to the Trash folder.

• Right-click on the contact and select .

When contact names are deleted, they no longer appear in your address book 
and information is not available from the name tool tips for the address auto-
completion or from the address search dialog in the email compose window.
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Sharing Your Address Books
You can share any of your address books. This is useful if your address books 
are for specific categories of contacts and want other users to have access to 
the names. Depending on the role you assign to the grantee, the shared 
contacts list can only be viewed or can have full access privileges to edit, add, 
and delete names. 

To learn more about how to share your address books, see Chapter 15, 
Sharing Your Account Items.
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8      Managing Your Calendar
This chapter explains how to:

• Choose a calendar view 

• Create calendars 

• View multiple calendars 

• Import and export your iCal calendars 

• Print a calendar 

• Delete a calendar 

The Zimbra Calendar lets you track and schedule your appointments, 
meetings, and events. You can switch between multiple views, drag and drop 
to move events from one calendar to another and share your calendars with 
others. 

Viewing the Calendar
To view the Calendar, select the Calendar tab in ZWC. The Work Week view 
is the default and is displayed when Calendar is opened the first time.

You can change which view is displayed when Calendar is opened from the 
Preferences tab > Calendar folder.

You can change your view from the Calendar toolbar, to see activities for a 
day, work week, full week, or month. Changing the Calendar view from the 
toolbar only changes the view for that session.
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Creating a Calendar
One calendar is created for you, and you can create additional calendars to 
keep track of different type of functions. For example, you can create one 
calendar for work, one for personal appointments, and one for company 
activities. Use the Schedule View to see calendars side-by-side.

To create a calendar

1. Select the Calendar tab in the ZWC.

2. Either:

• Right-click Calendars in the Overview pane and select New Calendar.

• Click the New arrow, , on the toolbar and select New Calendar. 

The Create New Calendar dialog appears.
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3. Type the name of the calendar into the Name field.

4. Select a color for displaying the Calendar’s activities using the Color menu.

5. Select the other options if necessary:

• Exclude this calendar when reporting free/busy times. Your free 
busy information on this calendar is not displayed to others when 
scheduling appointments 

• Synchronize appointments from remote calendar. When you select 
this option, a URL field appears. Enter a valid iCal file URL for the 
remote calendar. 

6. Click OK. The new calendar displays in the Calendar list.
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Adding Color to a Calendar
You can color-code calendars in your mailbox so that activities for that 
calendar always display in the selected color. When you are looking at 
activities from all calendars in one view, the color signifies activities on 
different calendars. There are eight colors available, and you can use a color 
more than once.

The above shows that gray, green, pink, and red calendars have activities on 
February 21, and the pink calendar has an all-day event.

To select a color for a calendar

• Select a color when you create a calendar.

• Select a color when you accept a calendar to share.

• Right-click on the calendar and select Edit Properties to change the color.

Viewing Multiple Calendars 
All of your calendars, including shared calendars, are visible in your Calendar 
list. Each calendar has a check box to the left of its name. Check the boxes for 
the calendars you want to view.
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The Work Week view is displayed by default, as shown above. You can 
change your view for this session only by clicking options on the Calendar 
toolbar. To change the default view of the work week, go to the Preferences > 
Calendar folder. 

The views are as follows:

•  is one day's activities.

•  displays Monday through Friday activities.

•  displays seven days of activities.

• Select which day is the first day of the week view using the Preferences > 
Calendar tab. 

•  displays a month's activities.

•  displays a list of appointments for a two-week period for all 
select calendars 

•  displays each calendar in a separate column. Check the boxes 
for the calendars you want to view.
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More about List view

The List view shows Calendar appointments for a two week period. Meetings 
from all selected calendars are listed by date and time showing details about 
the meetings, including subject, location, status, whether it is recurring or not 
and date and time of meeting.

You can change the columns that are displayed by right-clicking the header 
and deselecting the columns you do not want to display. You can sort the list 
by subject, status, calendar or date.

Multiple local appointments can be selected to act upon on once. You can 
delete selected appointments, move appointments to another calendar, or tag 
appointments. 

Note:   You cannot print the List view.

More About Schedule View

The Schedule View lets you see multiple calendars selected from your 
Calendar list. The day-view shows a time bar, a free/busy indicator, and the 
calendars side by side. The calendar name is in the header.
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You can click on any calendar to create appointments or to see details about 
an appointment.

The All column is a color-coded free/busy indicator for the viewed calendars. 
White indicates no activity. The deeper the red in this column, you have more 
overlapping appointments.

Move the mouse over the All column for tool tips that show which calendars 
have activity scheduled within a time period. 

Importing Your iCal Calendar
You can import iCalendars (iCal) calendars that are saved in the .ics format. 
iCalendars are the standard for calendar data exchange over the Internet, and 
.ics is the standard format for iCalendar information.

To import an iCal calendar

1. Select the Preferences Import/Export folder.

2. In Import, select Calendar as the type. 
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3. In Destination, either select an existing calendar to import the calendar into 
or you can create a new calendar.

4. Click Browse to locate the .ics file to import. 

5. Click Import.

6. Click OK. 

Depending on the size of the .ics file, the import may take a few minutes.

Exporting Your iCal Calendar
You can export calendars in the .ics format.

To export an iCal calendar

1. Select the Preferences Import/Export folder.

2. In Export, select Calendar as the type. 

3. In Source, select the calendar to export.
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4. Click Export . In the dialog that displays, select Save to Disk and click OK.

5. Select where to save the file and enter a file name.

6. Click Save. 

Seeing free/busy times
When you schedule meetings, you can view attendees, location, and resource 
schedules as you set up the meeting. To see the free/busy schedules, open 
an Appointment and click the Schedule tab.

In the first column, select the type of object to schedule — attendee, location, 
or resource. In the next column, enter the names and email addresses. 
Availability appears in horizontal bars next to the names, if the schedule is 
known. 

The free/busy information shows whether the attendee is busy, out of office, 
tentatively busy, or free.
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Sending your free/busy status to others

You can email a link of your free/busy status that shows appointments in your 
personal and shared calendars. Right-click Calendars in the Overview pane, 
and select Mail Free & Busy link.

The Compose Email window opens with the calendar link in the text area. Add 
more information to the email if you want and send the email to the user(s). 
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The recipient(s) can click the link to view your schedule. Your calendar 
updates itself for the recipient(s) when you add new events to your calendar.

Sharing Your Calendars
You can share your calendars with other people in your office, with external 
guests, and with the public. This can be useful if you maintain different 
calendars and want others to know your schedule. When you share your 
calendars with internal users, you can select the type of access the internal 
users can have:

• Manager which gives full access to view and modify the calendar

• Viewer, which gives read-only access. External guests and the public have 
read-only access

• Administrator, which gives full access to view, modify, share, and revoke 
calendar shares

You can also select the checkbox to allow internal users or groups and 
external guests to see your private appointments. They can view the 
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appointment and details if granted access. If you do not check the box, the 
calendar only shows that you are busy during a private appointment time.

To learn more about how to share your calendars, see Chapter 15, Sharing 
Your Account Folders.

Printing a Calendar
You can print individual calendars in any of the views but List view. 

1. Display any calendar view.

2. Click  on the toolbar. Your printer dialog appears, and the Calendar 
view to be printed displays. The example below is a Day view.

3. Click OK on your printer dialog. Close the Calendar Print view. 
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Deleting a Calendar
You can delete any calendar in your Calendars list, except your default 
calendar. 

To delete a calendar

1. Right-click on the calendar to be deleted.

2. Click Delete. The Confirmation dialog appears.

3. Click Yes.

The calendar is immediately deleted. There is no undo. However, the 
meetings that were created from this calendar are not automatically deleted 
from the invited attendee's calendars.
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9      Scheduling Appointments, Meetings, and Events
This chapter explains how to:

• Create an appointment, meeting or event

• Use QuickAdd to quickly create an appointment 

• Create recurring appointments or meetings 

• Change an appointment or meeting 

• Turn a message or a contact into a meeting request

• Respond to an invitation

Activities you schedule on a calendar are either appointments, meetings, or 
events.

• Appointments. An appointment is an activity without other people. When 
you schedule an appointment, no email is sent to confirm the appointment. 
You can set recurring appointments. QuickAdd can be used to quickly 
create an appointment.

• Meetings. Meetings are appointments that include other people. When you 
create a meeting, you select attendees and send an email invitation to 
them. You can reschedule meetings and set up recurring meetings.

• Events. An event is an activity that lasts all day. Events do not display as 
time on the calendar–they appear as banner at the top of the calendar 
schedule. 

All three types of activities can be entered in several ways. You can schedule 
an appointment from any calendar view and from other ZCS applications.

• In Mail, you can easily see your schedule or add new events without 
leaving Mail.

• In any email message, view your schedule in the body of an email 
message to make scheduling replies easy.
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• Create new event quickly just by typing free form text with Zimbra Assistant 
anywhere in ZCS. For more about Zimbra Assistant, see “Zimbra Assistant” 
on page 11.

Creating an Appointment or Meeting
There are several ways to create an appointment in the ZWC:

• Using the QuickAdd Appointment dialog.

• Using the Appointment Details tab.

• Dragging and dropping a message from the Inbox to the mini-calendar.

Note:  A meeting includes other attendees. An appointment is scheduled for 
yourself only. The steps to create appointments and meetings are the same 
with the exception of scheduling attendees–this step is not performed for 
appointments. Therefore, follow the steps in this Participant Guide for both 
creating appointments and creating meetings.

Opening the Appointment Details Tab

To use the Appointment Details tab to create an appointment:

• On the toolbar, click the arrow on  and select New 
Appointment. This option is available from the New menu in any view, 
except the Preferences view.

This action opens the Appointment Details tab.
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Opening the QuickAdd Appointment Dialog 

The following three methods open the QuickAdd Appointment dialog.

• Right-click on either the mini-calendar or the start time in one of the 
calendar views. You can select to create a New Appointment or a New All 
Day Appointment.

• Within an email message, certain text is interpreted as a date and triggers 
the ability to right-click to create an appointment. Text such as”today”, 
“tomorrow”, a day of the week (i.e. “Thursday”), or an exact date are 
highlighted in messages. 

• Hover the mouse over this type of text to see if you have an appointment 
scheduled. 

• Click on the highlighted text to open your calendar. 
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• Enter appointments directly on the calendar. In any calendar view, except 
Month, either:

• Click on the start time and drag through the end time. 

• Double-click the start time.

The QuickAdd Appointment dialog opens. 
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Creating a QuickAdd Appointment

All of the options previously described open the QuickAdd Appointment 
dialog. 

To create an appointment using the QuickAdd Appointment dialog

1. Specify the following information:

• Subject. Brief description of the meeting. The text added here becomes 
the description in the calendar.

• Location. Where is the meeting? If the location is in the company 
directory, when you start to type, locations that match are listed. You can 
also go to the Find Locations tab to search.

• Show As. Determine your Free/Busy options for this appointment. This 
information displays on the Schedule Attendees page.

.

• Calendar. Show all calendars in your Calendar List. The first calendar 
displayed is your original Calendar. 
       123



Zimbra Web Client User Guide
• Mark as. Mark an appointment as private or public. Details about events 
that are marked private do not display in a grantee's shared calendar. 
Only the start and end time, duration, recurrence information, and the 
organizer's identity are shown in the shared calendar.

• Start Time and End Time. Define the start and end day and time.

• Repeat. Define how often this appointment occurs.

• More Details. Opens the Appointment Details tab if you want to 
specify additional appointment information, such as Attendees and 
Resources. This is optional. Use of the Appointment Details tab is 
described next.

2. Click .

Creating a Meeting Using the Appointment Details Tab

This section describes how to schedule a meeting using the Appointment 
Details tab, including using the following:

• Details area

• Time area

• Find Attendees tab
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• Schedule tab

• Find Locations tab

• Find Resources tab 

To schedule a meeting from the Appointment Details tab

1. Click the arrow on  in the toolbar and select New Appointment. 
This option is available from the New menu in any view, except the 
Preferences view.

The Appointment Details tab appears.

2. Specify the following information in the Details area:
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• Subject. Brief description of the meeting. The text added here becomes 
the description in the calendar.

• Location. Where is the meeting? Either:

• Type the location. If the location is in the company directory, when 
you start to type, locations that match are listed.

• Go to the Find Locations tab. Use of the Find Locations tab is 
described later in this chapter.

• Type in a free-form location for the meeting. For example, an 
address of your favorite coffee shop. 

• Show As. Determine your Free/Busy options for this appointment. This 
information displays on the Schedule Attendees page.

.

• Mark as. Mark an appointment as private or public. Details about events 
that are marked private do not display in a grantee's shared calendar. 
Only the start and end time, duration, reoccurrence information, and the 
organizer's identity are shown in the shared calendar.

• Calendar. Show all calendars in your Calendar List.  The first calendar 
displayed is your original Calendar. 
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3. Specify the following information in the Time area:

• All day event. Select this option to make this appointment an all day 
event. Events do not display as time on the calendar, they appear as 
banner at the top of the calendar schedule

• Start Time and End Time. Define the start and end day and time.

• Repeat. Define how often this appointment occurs.

• Reminder. Set an alarm notification to remind invitees of the 
appointment. If the invitee has a different setting, their setting overrides 
your reminder settings.

4. Specify the following remaining information:

• Attendees. Either:

• Type the email addresses of your attendees, separating addresses 
with a semicolon (;). Names in your Contact list match what you type 
and are automatically displayed as you type.

• Go to the Find Attendees tab. Use of the Find Attendees tab is 
described later in this chapter.
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• Uncheck the Request Responses checkbox if you do not want to get 
responses from attendees. The checkbox is checked by default.

• Resources. Either:

• Type the email addresses of your resources, separating addresses 
with a semicolon (;). Resource names in your Contact list matching 
what you type are automatically displayed as you type.

• Go to the Find Resources tab. Use of the Find Resources tab is 
described later in this chapter.

• Body. Type an email message that will be included in the appointment 
invitation email

• Options. Either:

• Click  in the toolbar to include an attachment in the 
appointment invitation email.

• Click  in the toolbar to spell check the appointment 
invitation email.

5. Click .

Scheduling Attendees: The Find Attendees Tab
When creating an appointment from the Appointment Details tab, you can 
use the Find Attendees tab to search for attendees using your address books 
and your company GAL.

To use the Find Attendees tab

1. Click  in the Calendar view. The Find Attendees tab 
appears.
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2. Type a name into the Find field.

3. Select which list to use from the Source drop-down menu. The options will 
include your address books and the GAL (if your account is linked to a 
GAL).

4. Click Search.

5. Select the name(s) displayed.

6. Click either Add All or Add. Names are displayed in the Attendees for 
this Appointment area.

7. When complete, click . 

Viewing Free/Busy Times: The Schedule Tab
After selecting your appointment attendees, you can use the Schedule tab to 
see the free/busy schedules for attendees. If the attendee has set a 
preference to allow only certain users to see their free/busy information and 
you are excluded from the list, you cannot view their free/busy schedule.

To use the Schedule tab
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1. Click  in the Calendar view. The Schedule tab appears.

2. Use the Key area to determine the free/busy time for each attendee.

3. This column identifies the following:

•   Indicates that an attendee has not accepted the invitation yet.

•  Indicates a location.

•  Indicates a resource.

Scheduling a Location: The Find Locations Tab
When creating an appointment from the Appointment Details tab, you can 
use the Find Locations tab to search for locations using your address books 
and the GAL (if the GAL is linked to your Zimbra account).

To use the Find Locations tab

1. Click  in the Calendar view. The Find Locations tab 
appears.
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2. Type a search value into one of the fields. For example, type a location 
name into the Name field or type a site name into the Site field.

3. Click Search. Locations matching your search are displayed.

4. Select a location displayed.

5. Click Select. The location appears in the Location(s) for this 
appointment area.

6. When complete, click . 

Scheduling Resources: The Find Resources Tab
When creating an appointment from the Appointment Details tab, you can 
use the Find Resources tab to search for resources using your address 
books and your company GAL. Examples of resources include projectors and 
other electronic equipment.

To use the Find Resources tab

1. Click  in the Calendar view. The Find Resources tab 
appears.
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2. Type a search value into one of the fields. For example, type a resource 
name into the Name field or type a site name into the Site field.

3. Click Search. Resources matching your search are displayed.

4. Select the resource(s) displayed.

5. Click either Add All or Add. Names are displayed in the Resources for 
this Appointment area.

6. When complete, click . 

Note:  If you are adding an appointment to a shared calendar, you may need 
to refresh the screen to see the appointment.

Scheduling an All Day Event
To schedule an all day appointment, which is called an event in the ZWC, use 
the Appointment Details tab.

To schedule an all day appointment

1. Select the All day event option on the Appointment Details tab.
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If you are using the QuickAdd Appointment dialog, click the More Details 
button. This will open the Appointment Details tab from which you can 
select the All day event option.

Creating a Recurring Appointment
Recurring appointments are appointments that repeat on some sort of 
schedule. You can schedule recurring meetings to repeat daily, weekly, 
monthly, or yearly. In addition, you can customize recurring appointment 
schedules.

To create a recurring appointment

1. Select an option from the Repeat drop-down menu on either the QuickAdd    
 Appointment dialog or the Appointment Details tab.
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The  link appears.

2. Click  to display the Custom Repeat dialog.

3. Select options from the Custom Repeat dialog as necessary.

• Repeat. Use this drop-down to specify the frequency of the meeting: 
daily, weekly, monthly, or yearly. The remaining fields in this dialog 
change based on the repeat frequency selected.

• Daily. Customize daily repeats.

• Weekly. Customize weekly repeats.
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• Monthly. Customize monthly repeats.

• Yearly. Customize yearly repeats.

• End. Specify the end date and other information.

4. Click .

Changing an Appointment or Meeting
You can change any meeting or appointment, including the date, time, 
attendees, frequency (if repeating), at any time. If you created a recurring 
meeting, you can change one occurrence or the series of meetings. 

You can select to send or not send an email to attendees to update the 
meeting details.

There are two ways to change an appointment:

1. Double-click on the meeting you want to change.

2. Right-click the meeting you want to change and select Open. 
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If you are opening a recurring meeting, the Open Recurring Item dialog 
opens.  
Use this dialog to either change this single instance of a recurring meeting 
or to change the entire series.

3. The Appointment Detail tab appears. Change any information necessary 

and click .

4. Select whether to open only the selected date or to open the series. The 
Appointment page opens.

5. Make your changes. You can change the schedule, the attendees, add an 
explanation in the Text field and add an attachment.

6. If attendees do not need to reply to this meeting change notice, uncheck 
Request Responses. 

7. If you made a change that attendees don’t need notification, uncheck Send 
Notification Mail.

8. Click OK. An email is sent to the attendees if you did not uncheck Send 
Notification Mail.
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Deleting an Appointment or Meeting
If you created a meeting, you can cancel or delete it. If you created a recurring 
meeting, you can delete one occurrence or the entire series of meetings. An 
email is sent to attendees to inform them of the cancelled meeting. 

Note:  Only the originator of an appointment can cancel the appointment. 
Attendees can cancel the appointment on their own calendars, but attendees 
cannot cancel the entire appointment.

Deleting a Meeting

You can delete a meeting in two ways:

1. Right-click on the meeting in any calendar view and select Cancel. 

2. Click a meeting in a calendar and click  in the toolbar.

If you are canceling an appointment, a confirmation dialog appears. If you 
are an attendee and want to notify the organizer, click Notify organizer.

3. Click Yes to cancel or delete the appointment. The appointment is 
immediately removed from your calendar. You cannot undo the delete.

If you are canceling a meeting, a different confirmation dialog appears.
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4. Click Yes to edit the email sent to attendees. Edit the email as necessary, 
and click Send to send the cancellation message.

The appointment is immediately removed from your calendar. An email is 
sent to the attendees, and the appointment is deleted from their calendars. 
You cannot undo a delete.

Deleting a Recurring Appointment

There are two ways to delete a recurring appointment:

1. Right-click on the appointment in any calendar view, select Instance or 
Series, and select Delete. 

2. Click an appointment in a calendar and click  in the toolbar. A 
dialog appears where you can specify the instance or the series.
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3. Select whether to delete the instance or to delete the series, and click 

. A confirmation dialog appears. 

4. Click Yes to delete the meeting instance or series. The appointment is 
immediately removed from your calendar. An email is sent to the attendees, 
and the appointment is deleted from their calendars. You cannot undo a 
delete.

Printing an Appointment or Meeting
To print appointment and/or meeting information, refer to Printing a Calendar 
in Chapter 8.

Creating a Meeting Using Drag and Drop: Turning a 
Message or Contact into a Meeting Request

You can quickly create a meeting request by simply dragging and dropping a 
message, conversation, or contact to a date on the mini-calendar.  When you 
drag and drop a message or conversation, the information in the message is 
used to populate many of the fields on the Appointment page.

• The Subject of the appointment is the subject of the message.

• The attendees are the email addresses in the To and Cc fields of the 
message or for conversations, the most recent message in a conversation. 
When you drag a contact from your Contacts list to the mini-calendar, the 
contact's first email address is added to the attendee field.

• The text of a message or the text of all messages in a conversation thread 
becomes the text of the invitation.

Turning a Message or Conversation into a Meeting Request

To turn a message or conversation into a meeting request

1. Click on a message or conversation and drag it to a date on the mini-
calendar. 

The Appointment Details tab appears. 
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2. Review the meeting request details and make any necessary changes.

3. Click . A meeting invitation is sent to all attendees.

Turning a Contact into a Meeting Request

To turn a contact into a meeting request

1. Click on a name from your Address Book list and drag the name to a date 
on the mini-calendar. 
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The appointment page opens with the contact name in the Attendees field.

2. Finish the meeting request details: add a subject, select a time, add more 
attendees, etc.

3. Click . A meeting invitation is sent to the contacts.

Responding to a Meeting Invitation
When you receive an email notification for a meeting, the meeting is added to 
your calendar and marked New. You can quickly respond to the invitation 
either from the email Inbox or from the Calendar List pane.

To respond to a meeting invitation

1. Open the message that contains the meeting request by either:

2. Clicking on the invitation email in the Inbox.

3. Right-clicking the appointment in the Calendar List pane and select New. 
The meeting invitation appears.
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4. Select an action. There are three actions:

•  Accepts the meeting.

•  Shows the meeting in orange in your calendar.

•  Removes the meeting from your calendar.

5. Click any of these actions to automatically send a reply to the meeting 
organizer indicating your response, either I will attend; I might attend, or 
No, I won’t attend.

6. Click the arrow on the action and select Edit Reply to add comments to the 
reply email. This is optional.

If the meeting is a recurring meeting, you have the option to reply for an 
Instance or the Series.

To add comments when responding to a meeting invitation in Calendar List 
pane, right-click the appointment and select Edit Reply.
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After you make your choice, the invitation is moved to the Trash, and New is 
removed from the calendar notice. Declined appointments display on your 
calendar in a faded view, as a reminder of the meetings you declined. You can 
delete the declined meetings any time.

Note:  If you would prefer to have the invitation email remain in your Inbox, 
change this preference on the Preferences > Calendars tab.

To read the message or to see any attachments that may have been sent, 
click the meeting notice.

The reminder settings you set in Preferences > Calendars override any 
reminder settings that you receive in a meeting invitation.

Changing Your Response to a Meeting Invitation

If you decide to change your response to a meeting invitation, for example, if 
you want to accept a previously declined meeting:

1. Right-click the meeting in your calendar.

2. Select Accept from the menu.

An automatic response is sent to the meeting organizer to indicate that you 
have accepted the meeting.
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This chapter provides an overview of many of the preferences that you can 
configure for your account. It explains how to: 

• Create away messages using the Mail tab

• Create email signatures using the Signatures tab

• Create additional email personas and link to external email accounts 
using the Accounts tab

The key functionality for each of these is covered in detail in other chapters 
of this user guide. This chapter provides a high-level overview.

Your default user preferences are configured when your account is created. 
You can change the default settings from the Preferences tab. When you 
select Preferences, the associated folders display in the Overview pane. 

If an option described here is not visible in your view, it is not available for your 
account. 

Saving, Canceling, and Reverting Changes to Preferences
There are three things you can do on each Preferences page:

• Click  in the toolbar to save any changes you made on the page. 
This saves your changes and returns you to your ZWC view.
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• Click  in the toolbar to cancel any changes you made on the 
page. This cancels your changes and returns you to your ZWC view.

• Click  in the top right corner of any Preferences page to 
reset any changes for that page to your last saved settings.

This revert feature does not affect changes to passwords.

General Folder

Use the options on the Preferences > General tab as follows:

• Login using. Defines your default Client Type at log in.

• Advanced. Offers the full set of Web collaboration features. This Web 
Client works best with newer browsers and faster Internet connections. 

• Standard. Recommended when Internet connections are slow, when using 
older browsers, or for easier accessibility.

• Theme. The background color for your mailbox interface.

• Language. The language used to display the text in the ZWC.

• Default Time Zone. The default time zone for your account.  This can be 
different from your computer time zone configuration.Note: In the Standard 
web client, this time determines the date and time for messages that you 
send or receive and the time to display for Calendar appointments. 
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• Change password. Used to change your password. If you have trouble 
changing your password, or if this button is not displayed, contact your 
administrator for password help.

• Search Settings. Check Include Junk Folder in Searches and/or 
Include Trash Folder in Searches to include these folders in any search 
you perform. By default these folders are not searched.

• Search Language. Check Show advanced search language in search 
toolbar to show search string details in the search text box at the top of the 
ZWC window. 

• Settings. Check Display checkboxes to quickly select items in lists 
(requires refresh) to display a checkbox for each item in the Content 
pane. When this is enabled, use the checkbox to select one or more items 
to perform the same action on, such as delete, move, or mark as read/
unread.

Mail Folder
In the Mail folder you can

• Select how messages are displayed

• Set up how your mailbox handles messages that are received

• Create an auto-reply message that can be used when you are away. 

• If you are set up to use a POP3 client, you can configure the POP access 
behavior when messages are downloaded to the POP client.

• Set junk mail options to block messages and to allow messages from 
addresses you specify. For detailed steps on setting up junk mail option, 
see Chapter 2.

Use the options on the Preferences > Mail folder as follows:
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Displaying Messages

• Check for new mail every. Select the polling interval, which is how often 
your computer checks for new email. The default is every 5 minutes. The 
minimum length of time is defined by your administrator.

• Display Mail. Select As HTML (when possible) to display messages with 
HTML formatting, for example, with bold, colored, or otherwise styled text. 
Select As Text to display messages in plain text format. In plain text 
format, HTML tags are displayed, not applied as markup.

• Message Preview options:

• Select whether to display snippets of messages in email list. When on, 
the first line in the email is displayed when the cursor is over the subject 
of a message. When off, only the first few words of the message are 
displayed.

• Select whether a double-click will open messages in a new window.

• Images. Select whether to download pictures automatically to your HTML 
email message.

• When I read a message in the reading pane. Select if the message 
should be marked as read immediately, after the specified time in seconds, 
or should not be marked as read at all.
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• After I move or delete a message. Select where the cursor should move 
after you move or delete a message

• Default Mail Search. Defines the search to execute when you log in. The 
results of this search are displayed in the Content pane when you log into 
your mailbox. The default search is your Inbox. Therefore, when you log in, 
the results of your Inbox display. You can change this field to have another 
folder, tag, or a saved search displayed when you first open the Zimbra 
Web Client.

Receiving Messages

• When a message arrives. 

• Play a sound. Select if a sound should be played. A Windows Media or 
Quicktime plugin is required. A beep is played when a new email arrives 
in the Inbox. If your computer volume is set to mute, you will not hear a 
sound.

• Highlight the Mail tab. Select if the Mail tab should be highlighted when 
a new message arrives and you are not working in the Mail tab.
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• Flash the browser title. Select if the browser title should flash when 
you receive a new message.

• Show a popup notification. Select if the browser should show a popup 
notification. You must have Yahoo!BrowserPlus to use this option.

• Forward a copy to. Specify an address to which you want to forward 
your email. Select the checkbox if you do not want to keep a copy of the 
forwarded message in your mailbox. 

• Send a notification message to. Specify an address where you want 
to be notified of new email in your ZWC mailbox. 

• Send auto-reply message. Use this to send an away message saying 
that you are out of the office. Specify the text for the message using the 
field provided. Set the Start and Stop dates for which this auto-reply 
message should be used. For steps on creating an auto-reply message, 
refer to Chapter 6.

• Read Receipt. Specify how to handle email messages you receive that are 
flagged to send a return read receipt message back to the originator. The 
following options can be set:

• Never send a read receipt. This is the default. When a message is 
received with a return read receipt request, the request is ignored. The 
recipient is not aware of the request.

• Always send a read receipt message. A return read receipt message 
is automatically sent when the message flagged for return read receipt 
is opened.

• Ask me. Recipients are asked if they want to send the return receipt.

• Messages from me. Use this section to handle messages you send that 
include your address as one of the recipients of the message or that are 
included in an address, such as a mailing list, that includes you.

Access from Other Mail Clients

• POP Access. Select if all mail, including old mail should be downloaded or 
only new mail should be downloaded from your external mail client.
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Composing Messages Folder

Use the options on the Preferences > Composing folder as follows:

• Compose. Select your default text editor, either HTML or text. 

Set the default font settings to be used when using HTML to compose in 
Email, Documents, and Calendar. You can define the font style, size, and 
color to use as your default style. Verdana, 12 point black is the default.

• Reply/Forward using format of the original message. Even if your default 
text editor is different from the message received, check this box to reply to 
the message in the same format it is received in. This is useful to make 
sure the recipient can get the message in the best format they can read.

• Always compose in new window. When selected, a new compose window 
opens, separate from your mailbox, when you compose a message. You 
can view and navigate your mailbox while the compose window is open.

• Mandatory spell check before sending a message. If you want to have all 
messages spell checked automatically before they are sent, enable this 
feature.

• Automatically save drafts of messages while you are composing. When 
selected, drafts of messages are saved every few minutes. If you prefer not 
to have messages automatically saved, disable the feature.
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• Reply / Reply All. Select whether to include the original text in the body of 
your reply message. You can choose:

• Include original message

• Don’t include original message

• Include original message with the prefix below (either > or | )

• Include original message as an attachment

• Include original message and headers with the prefix below

• Include last message only. Includes only what was written by the person 
who sent the last message, and not previous text

• Forward. Select whether to include the original text in the body of a 
forwarded message. You can choose:

• Include original message

• Include original message with the prefix below (either > or | )

• Include original message and headers with the prefix below

• Include original message as an attachment

• Prefix. Specify whether to prefix each line with > or | for email messages 
that are forwarded or replied to, if you chose to include the original 
message text.

• Sent Messages. Specify whether or not to save a copy of sent messages 
in the Sent folder. By default, the Save copies of messages to sent 
folder is enabled.

Signatures Folder
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You can create signatures for your email messages. This is a task commonly 
performed by end-users. For detailed steps on creating an email signature, 
refer to Chapter 3.

Your signature can include your name and additional closing text to the 
maximum number of characters that your account allows. If you create 
multiple identities, you can create different signatures and assign them to 
specific addresses.

Type a name that identifies the signature into the Signature Name field. You 
can create multiple signatures, so using an identifiable name here is 
important.

1. Type the signature text into the text box exactly as you want it to appear. 

2. Specify in the Using Signatures section where you want your signature 
displayed.

3. Select Above included messages to add your signature at the end of the 
your composed, replied to, or forwarded text.

4. Select Below included messages to add the signature at the end of the 
message.

5. Click Save.

Address Book Folder

Use the options on the Preferences > Address Book folder as follows:

• Default View. Choose to display contacts either in a list view or in business 
card view.
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• Settings. Select Add new contacts to “Emailed Contacts” to 
automatically add addresses to your address book when you send email. If 
this is enabled, addresses are saved to your Email Contacts folder.

Select Auto-complete includes addresses in the Global Address list to 
use the GAL as well as your address book to look up addresses when 
composing an email or setting up a meeting.

Select Initially search the Global Address List when using the contact 
picker to look in the GAL when adding contacts to an email or meeting.

Note:   If you enable these Global Address List option, you may find that you 
get too many results for auto-complete or search if your company has a very 
large Global Address List.

Accounts Folder

The Accounts folder is used to create and manage your personas and 
external email accounts. Persona is the email identity used in the From field of 
email messages you send.

Adding external accounts and personas are tasks commonly performed by 
Zimbra end-users. For detailed steps on these tasks, refer to Chapter 6. 

Mail Filters 
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Use the Mail Filters tab to define email filtering rules. 

Refer to Chapter 5 for further information on creating and using filters.

Calendar Folder

Use the options on the Preferences > Calendar folder as follows:

• Default View. Select how you would like to view your Zimbra calendar. The 
default is by work week. The view options include: Day, Work Week, 7 Day 
Week, Month, List, and Schedule.

• Start Week On. Specify which day of the week should be the first day of 
the week in your calendar.

• Default appointment visibility. This can be set to either Public or Private. 
The default is Public, all incoming calendar invites are marked as Public, 
unless the creator marked the meeting notification as private. When Private 
is set, all incoming calendar invites are marked as Private. Details about 
events that are marked Private do not display. 

• Always show the mini-calendar. Specify whether the mini-calendar is 
displayed at the bottom of the Overview pane.
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• Automatically add received appointments to calendar. When this is 
checked, email invitations sent to your Inbox are automatically added to 
your calendar. You can accept or decline the invite from either the Inbox or 
Calendar. When this is not checked, the appointment is added to your 
calendar when you click Accept or Tentative in the message.

• After responding to an invitation. Specify whether to automatically delete 
invitations from your Inbox after you respond to them.

• Show reminders. Set the number of minutes before an appointment to be 
reminded. The default is five minutes. You can also choose to Play a 
sound with the reminder. If your computer volume is set to mute, you will 
not here a sound. Select Flash the browser title if you are working in a 
different browser tab or browser window and choose to have the browser 
title flash to remind you.

Creating Appointment Options

• Use the QuickAdd dialog when creating new appointments. Specify 
whether to create new appointments using the QuickAdd dialog. This is 
often helpful if you create many appointments without attendees.

• Show time zone list in appointment view. Select if you often schedule 
meetings with others in different time zones.
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Setting Permissions

• Free/Busy. Set preferences to allow all or specific users to view your free/
busy information

• Invites. You can specify who can invite you to meetings. Set preferences 
to allow all or specific users to invite you to meetings. If you limit who can 
invite you to meetings, you may want to select to send an auto-reply 
message to those users denied permission to let them know they do not 
have permission to invite you. 
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Sharing

The Sharing folder shows items that are shared with you and items that are 
shared by you. You can also find items that have been shared with you but you 
have not yet accepted the share. See Chapter 15, Sharing Your Account 
Folders.

• Folders that have been shared with me but not yet accepted. In this 
section you toggle between two views:

• Show folders shared with me through a distribution list. This option 
is selected by default. If folders are shared with you through a DL, the 
fields are populated with the shared item information.

• Show folders shared with me by the following user.... When you 
select this option, enter a name of a user that has shared an item with 
you. The information is displayed in one of the fields depending on 
whether you have accepted a share invitation or not. You can view 
information from one user at a time. The details are not saved.

• Folders shared with me that I have accepted. In this section, the folders 
that are shared with you are listed.

• Folders shared by me. In this section your shared folders are listed with 
details about how the share was set up, including the role you assigned the 
user and the item shared. You can edit the share properties, revoke 
permissions to your share, and resend the invitation.
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• Share a Folder. You can share your email, address book, calendar, tasks, 
notebooks, and briefcase folders from here as well.

Mobile Devices
(ZCS Network Edition only)

If you have the Mobile feature enabled, the Mobile Device folder is available 
from the Preferences tab. This folder shows mobile devices you configured to 
sync with your ZWC account. From this folder, you can sync from the server to 
your mobile device or suspend a sync. You can also delete mobile devices 
you no longer use.

Wiping Your Mobile Device

If your mobile device is lost or stolen, you can remove all the content on the 
device using the Wipe Device link on the page. This command erases all 
data on the device and returns the device to the original factory settings.

Do not run this command to clean up a device that you still have in your 
possession.

To wipe a lost or stolen device

1. Click Preferences and select the Mobile Device folder.

2. Select the device to wipe and click Wipe Device.

The status will show Wipe Pending. The server is waiting for the device to 
connect to the server to initiate the request. When the device connects to 
the server, the device is wiped. The status changes to Wipe Complete.

If you find the device before it is connected to the server, you can cancel 
the wipe device request as long as the status is Wipe Pending.
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Import/Export

The Import / Export folder can be used to import or export your complete 
account data, specific folders, calendars, and contact lists. The ability to 
export all of your account data is useful if you want to backup your account or 
a specific folder to your computer. See the appropriate chapter for information 
about how to import or export items. 
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Shortcuts Tab

Keyboard shortcuts let you use the application without going to the mouse.The 
shortcuts are listed in the Shortcuts folder and you can print them. 

To quickly see a list of shortcut keys, type Ctrl Q from any view in your 
mailbox.

Zimlets
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Zimlets are add-on applications that enhance the functionality of your mailbox. 
The system administrator enables the Zimlets. All the Zimlets that you can use 
are displayed in the Preferences Zimlets page. Some Zimlets enhance your 
user experience and are enabled by default. These include the following:

• Date. Hover the cursor over any date in a message.The date is highlighted 
and your Calendar appointments associated to this date are displayed.

• Phone Numbers. Click on a phone number in a message to quickly place 
a call. VOIP software such as Skype or Cisco VOIP phone must be 
installed on your computer. Right-click on the phone number to add the 
phone number to a contact form.

• URL. Click a URL to go to the website specified in the email message.

• Email addresses/name. Click on an email address in the header of a 
message to see if the name is in your Address Book. Click again to add the 
name to your Address Book

Other Zimlets that you enable are listed in the Overview pane, Zimlets section. 
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11      Using Task Lists
This chapter explains how to:

• Create a new task list

• Manage your tasks and task lists 

You can use your task lists to create and track the progress of a task. In 
addition, you can write notes within your task and attach files for easy access 
from within the task. Having all the relevant information with your task is useful 
when you share your task list with others.

To view your task lists, select the Tasks tab in ZWC.

For simple tasks, all you may need to do is create a task from the Content 
pane. If a task needs to be managed, you can add more details, define a start 
and due date, set the priority to the task - high, normal, or low, and keep track 
of the progress and percentage complete.

Creating a New Task List
There are two ways to create a new task list:

1. Click the arrow on  in the toolbar and select Task. This option is 
available from the New menu in any view, except the Preferences view.

Or click on  above the Task List display.
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Using either method, the Create New Task List dialog appears.

2. Enter a name for the task list in the Name field.

3. Select a color for the tasks on this task list.

4. If you want to synchronize this task list with a remote service, check the box 
and enter the URL.

5. Click . The task list is displayed in the task list display. In the 
example below, the new task list is Training Tasks, which is pink.

Creating a New Task
There are two ways to create a task:

1. Click the arrow on  in the toolbar and select Task. This option is 
available from the New menu in any view, except the Preferences view.
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The Tasks Details tab appears.

2. Specify the following information in the Details area:

• Subject. Brief description of the task. The text added here becomes the 
description in the task list.

• Location. Where does the task occur, if applicable?

• Priority. Select the priority for this task.

• Task List. Select the task list where you want this task displayed. 
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Specify the following information in the Progress area:

• Status. Select the status for this task. You can reopen this task and 
change this status at any time.

• Percentage. Select a percentage to go with the status of the task. You 
can reopen this task and change this percentage at any time.

3. Define the start and end day and time for the task.

4. Specify the following remaining information:

• Body. Type any notes to be included in the task list.

Options: 

• Click  in the toolbar to include an attachment for the task.

• Click  in the toolbar to spell check the task body.
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• Click .

Adding a Task Quickly
To quickly add a new task to a task list:

1. Open the task list to which you want to add a task. Double-click on the task 
list in the Tasks area of the Overview pane to open a task list.

2. Click the message Click here to add a new task.

3. Type a name for the new task and press Enter.

This adds the task subject to your task list, but it does not give any details. 
To add details, edit the task.

There are two ways to edit the task information:

• Double-click the task.

• Click the task and click  in the toolbar. The Task Details tab 

appears. Edit the information displayed and click .

If you add or create a task in the wrong task list, either:

• Open the task, and select the correct task list from the Task Lists drop-
down.

• Drag and drop the task on the Content pane to the correct task list in the 
Overview pane.

Note:  You can use Zimbra Assistant to quickly add a task while working 
within an email message, a meeting within calendar, or viewing a contact. 
 When the task is created, any of the information that was available is added 
to the Task text area. For more information on Zimbra Assistant, refer to 
Chapter 1.
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Changing or Updating a Task
As you progress on a task, you may want to change its status and % complete 
information.

To update a task:

1. Open the task list you want to update. Double-click on the task list in the 
Tasks area of the Overview pane to open a task list.

2. Edit the task information using one of these two methods:

3. Double-click the task.

4. Click the task and click  in the toolbar.

The Task Details tab appears.

5. Edit the information displayed and click .

Moving a Task
You can move a task to another list in one of the following ways:

• Using the Move option from the right-click menu

• Using drag-and-drop
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• Editing the task details

To move the task using the Move option:

1. Right-click the task and select Move. 

The Move Task dialog appears. 

2. Select the task list to which you want to move the task and click OK.

To move the task with drag-and-drop:

Select the task to move, hold down the left mouse button and drag the task to 
the lists in the Overview pane.
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To move a task by editing the task:

Open the task page and in the Task Lists field, select the task list.

Deleting a Task
To delete a task from a task list:

1. Open the task list containing the task you want to delete. Double-click on 
the task list in the Tasks area of the Overview pane to open a task list.

Delete the task using one of the following methods:

2. Select the task to delete and click  on the toolbar.

3. Right-click on the task and select Delete. Click Yes in the Confirmation 
dialog.
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Sorting Tasks 
You can sort tasks in a task list by subject, status, percentage complete, and 
due date.

To sort tasks:

1. Open the task list containing the tasks you want to sort. Double-click on the 
task list in the Tasks area of the Overview pane to open a task list.

2. Click on any of the following column headers to sort the tasks by that 
column:

• Subject

• Status

• Percentage Complete

• Due Date

Printing Your Task List
You can print a complete task list or just print information for one task.
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1. On the Task toolbar, click  and select whether to print the selected 
tasks or to print all items in the Task folder. 

2. In the Print dialog, click OK.

Search for Tasks by Status
You can search for tasks by specific status.

On the Task tool bar click View and select which type of tasks you want to 
view.

Import Task Lists
You can import task lists that are saved to a .tgz file.

To import a task list

1. Select the Preferences and click the Import / Export folder.

2. In the Import section, select the type as Account

3. Check the Advanced Settings box

4. Remove the checkbox from all applications except Tasks.
 172      



Using Task Lists          
5. For the Destination, click on All folders and select the task list that the tasks 
will be imported into or create a new task list.

6. In the File field, click Browse to locate the task list tgz file to import. 

7. Click Import . 

Depending on the size of the .tgz file, import may take a few minutes.  

Exporting a Task List
Your task list is exported and saved in a .tgz file format. 

To export an address book

1. Select Preferences, and click the Import / Export folder

2. In the Export section, select the type as Accounts.

3. Check the Advanced Settings box

4. Remove the checkbox from all applications except Tasks.
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5. In the Source area, click All Folders to select the task list to export

6. Click Export.

7. Check Save to disk and click OK. 

Sharing Task Lists
You can share your task lists with other people in your office, with external 
guests, and with the public. When you share your task lists with internal users, 
you can select the type of access the internal users can have, either manager 
which gives full access to view and modify a task, or viewer, which gives read-
only access. External guests and the public have read-only access. See 

To learn more about how to share your tasks, see Chapter 15, Sharing Your 
Account Folders.
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12      Working in Documents 
This chapter explains how to:

• Create notebooks  

• Create and design pages using a rich text editor or using HTML 

• Upload and link files and images to different pages 

• Search through all notebooks, pages, and attachments 

• Share notebooks and notify them when changes are made to a page

Zimbra Documents is a document sharing and collaboration application that 
gives you a central place on the ZWC to develop and organize information. 
Images, spreadsheets, and other rich Web content objects can be embedded 
into Document pages. External documents can also be uploaded. The pages 
display in your browser.

Zimbra Documents is made up of notebooks with individual pages that are 
organized in a table of contents with version history. 

Creating a New Notebook
By default, every ZWC account includes one notebook. You can create as 
many additional notebooks as you need.
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To create a new notebook:

1. Click the arrow on  in the toolbar and select New Notebook. 
This option is available from the New menu in any view, except the 
Preferences view.

2. Click on Notebook icon in Notebooks in the Overview pane.

Using either method, the Create New Notebook dialog appears.
 176      



Working in Documents           
• Enter a name for the notebook in the Name field.

• Select a color for the notebook.

• Select the location for the notebook.

3. Click . The notebook is displayed in the notebook area of the 
Overview pane. In the example below, the new notebook is Training 
Notebook, which is pink.

Note:  All notebook names must be unique within the hierarchy of your 
mailbox folders. Notebooks cannot have the same name as any top-level 
folder in your Zimbra email, calendar, or address book.

Creating a New Page
You can create a page in a notebook. On any page, you can:

• Design the content layout using either rich-text format tools or HTML tags

• Check the spelling on the page

• Use keywords to easily create links to other pages

To create a new page in a notebook:

1. Open the notebook to which you want to add a page. Double-click on the 
notebook in the Notebooks area of the Overview pane to open a notebook.

The table of contents page displays in the Content pane. 
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2. Click  on the toolbar. A blank page appears.

3. Enter the name for the new page in the Page field in the header. This name 
displays in the table of contents.

4. Compose the content of the page. Later you can use either of the following 
to format this page (instructions for both methods are described later in this 
chapter)

• Default rich text editor to add styles, color, tables, and spreadsheets to 
your page

• HTML tags 

5. Click  to save the page. You can now proceed to format the page, 

or click  to return to the table of contents page.

Formatting a Notebook Page: Overview
You can compose your pages using either the rich-text editor to format the 
content on the page or HTML source to format your page using HTML tags. 
You can switch between the two formats to take advantage of the rich-text 
editor features and to insert tables and spreadsheets.

Formatting a Page Using the Rich-Text Editor

When you edit using the rich-text editor, the two-row toolbar lets you easily 
format your page layout. Select, change, or add the following:

• Font sizes, faces, and colors

• Text styles

• Background colors
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• Tables

• Spreadsheets

• Attachments

• Images

These formatting tools work the same as many word processing tools. 

Adding a Paragraph Style

Use the  icon on the toolbar to view the available paragraph styles. The 
styles include:

• Normal for most paragraphs

• Headings (six levels) to identify section titles

• Address to make text italic

• Preformatted to use when you want to display text in Courier font

These styles cannot be modified, but you can use the editing options to format 
a style differently. For example, you can change the font, size, color, etc. 

Adding a Table to Your Page 

Adding tables to your page is a three-part process: add a table, configure the 
table properties, and then add content to the table.

To add a table to a page:

1. Click  on the toolbar. The table menu is displayed.
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2. Select Insert Table, and select how many rows and columns should be in 
the table. 

The table is added to the page.
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• To set the table properties, click  on the toolbar and select Table 
Properties. The Table Properties dialog appears.

You can define table alignment and width; text style, including font color 
and table background; and border style, including cell padding. 

• To set the cell properties, click  on the toolbar and select Cell 
Properties. The Cell Properties dialog appears. 
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You can define border style for the cell, layout and text styles, including 
font and background color for a cell.

You can also click  on the toolbar to insert more rows and 
columns and merge or split cells after you create the table. 

After the table properties are set, click on a cell to begin to type text.

Adding a Spreadsheet to Your Page

To add a spreadsheet, click the spreadsheet icon  on the toolbar. A six-
column spreadsheet is added to the page. 
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Spreadsheets can be used to create databases to keep track of lists of 
activities, schedules, tasks to do, etc. The spreadsheet includes basic 
spreadsheet functionality and a set of predefined functions.

Adding Attachments, Images, and Links to Your Page 

You can upload files and images that link to the notebook page. 

• Click  to add a file.

• Click  to add an image. 

• Click  to add a link. You can link to other notebook pages or to an 
external Web URL. Give the link a descriptive title so the URL address 
does not display.

Browse to find the file or image to be uploaded, or enter a descriptive title for a 
link (this will be displayed instead of the URL). You are notified if you upload a 
file that already exists in your Documents.

Formatting Using HTML Source
If you know HTML, you can use HTML tags to create your content.  All basic 
HTML elements can be used.

To create pages in HTML:

1. Click Format on the toolbar and select HTML Source.
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Sharing Your Notebooks
You can share your notebooks with other people in your organization, with 
external guests, and with the public. When you share your notebooks with 
internal users, you can select the type of access the internal users can have, 
either manager which gives full access to view, create and edit the notebook’s 
content, or viewer, which gives read-only access. External guests and the 
public have read-only access.

You can notify people with whom you share when you make changes to a 
page directly from that page. Click Send on the toolbar.

To learn more about how to share your notebooks, see Chapter 15, Sharing 
Your Account Items.
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13      Briefcase
This chapter explains how to:

• Create Briefcase folders

• Upload any type of file to your Briefcase 

• Save attachments sent in email messages to your Briefcase

• Work in files in Briefcase 

The Briefcase application is used to save files directly to you account, making 
it easy to access these files anytime you log in to your account from any 
computer. You can share your briefcases folders with others who can view and 
edit the files in the shared Briefcase.

You can create multiple briefcase folders and then upload any type of file from 
your computer or your computer network, save attachments sent with your 
email messages, and create new documents.

Files in Briefcase are copies of the original file, whether the file is on your 
computer or an attachment to your email. Changes you make to files in your 
briefcase do not change the original file.

Note:   Files in your Briefcase can also be accessed from a WebDAV Client.

Creating Briefcase Folders
1. Click the Briefcase tab. 

2. Click New Briefcase on the toolbar.
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The Create New Briefcase dialog displays. 

3. Type a name for the new briefcase folder.

The briefcase folder name must be unique within the hierarchy of your all of 
mailbox folders.  This name cannot match any top-level folder in your 
mailbox, calendar, or address book. For example, if you have a calendar 
named Holidays, you cannot name a top-level briefcase Holidays. Holidays 
could be a name of a briefcase within another briefcase.

4. Select the folder hierarchy, either under Folders or under another briefcase 
folder. You can create a new top-level briefcase, or you can place it under 
an existing briefcase.

5. Click OK. The new briefcase displays in the Overview pane.

Adding Files to Your Briefcase Folders
Uploading a file transfers a file from your personal computer to your ZWC 
account. This makes the file available any time you log into your account.  You 
can upload files in the following ways: 

• Clicking attachments you receive with your email messages.

• Using the file upload tool when working in Briefcase

• Using WebDav Client tools

To upload files from Briefcase

1. Open Briefcase, select the Briefcase to save the file and then click Upload 
file on the toolbar.
 186      



Briefcase          
2. In the Upload dialog click Browse to find the file to upload. 

3. To add another file, click Add. 

You cannot upload a file with the same name to the same briefcase. You 
can specify on the Upload dialog how to files with the same name should 
be treated when you attempt to upload the file. When you change this 
option, the change is saved in the dialog.

• If you want to be notified that you are uploading a file with the same 
name, select Ask Me. If a file has the same name as an existing upload, 
the Upload Conflict dialog displays.  You can either keep your existing 
file or replace it with the uploaded file. You can also view the new file. 
This the default.

• If you want the file you upload to replace the existing file with the same 
name, select Replace With My File. The new file is uploaded and 
replaces the existing file. You are not notified of this.

• If you do not want the files in your Briefcase to be replaced, select Keep 
Existing File. The file is not uploaded and you are not notified.

4. When all files are uploaded, click OK. The file is displayed in the Briefcase. 

Note:  If you selected the wrong briefcase, you can use drag and drop to 
easily move the file to the correct briefcase folder.

Your account may have a maximum size for upload files. If the file is too large, 
a warning is displayed. Files that you upload impact your account quota. 

To upload email attachments to Briefcase:

Email attachments can quickly be added to your briefcase. 
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1. To add the attachment, click the add to briefcase link in the message 
header next to the Attachments link.

2. In the Add to Briefcase dialog, select the destination folder or create a 
new briefcase folder. 

3. Click OK. 

Note:   A copy of the attachment is put in our Briefcase folder. If you are 
managing your quota, you may want to delete the attachment in the email 
when you add upload the attachment to your Briefcase.

Viewing Files in Briefcase
You can select how to view your files in your Briefcase folders. On the 
Briefcase toolbar select one of these options from the View menu.

• Explorer View. Files are displayed as thumbnails.

• Detail View. Files are displayed in a horizontal line with the file size, date 
uploaded, owner, if a shared file this may not be you, and which folder the 
file is in.
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• Column Browser View. Files are displayed vertically. In this view you can 
click on a file to see information about the file, including size, create date, 
creator, modified date and modifier.

In addition, you can view files using a WebDev client.

Working in Briefcase
In Briefcase, you can open files to work in them, move files, tag files and send 
an email with a link to a file in your Briefcase. 

Opening files in Briefcase

You can open files in your briefcase from any computer. You must have the 
appropriate software application to open and read or update the file. Common 
file formats such as text files, HTML files, and images such as .gif or .jpg files 
can be opened in a variety of programs. 

To open a file, right-click on the file and select Open. 

If the type is unknown, a dialog displays asking what to do with the file, save to 
disk or open with a specific application.

Moving files

You can move files from one briefcase to another.

1. On the toolbar, click . 

2. Select the destination folder or create a new briefcase folder. 
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3. Click OK. 

Tagging files

1. Click on the file and on the toolbar, click . 

2. Select the tag. 

3. Click OK. 

Tags only display in the Detail view.

Sending an email with a link to a file 

You can send an email that has a link to a file in briefcase. The recipient must 
have appropriate share permission to work with these file and the appropriate 
software to open the file. Any modifications they make to a the linked file are 
reflected in the file in your Briefcase folder. 

1. Right-click on the selected file in a Briefcase folder. 

2. Select Send link(s). A confirmation pane opens reminding you that the 
recipient must have permission to view the content of the folder. Click Yes 
to proceed.

 

3. A new compose email message opens with the link displayed in the body of 
the message. Complete the email message and click Send to mail the 
message. 
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Sending a file as an email attachment

You can send a file as an attachment to an email directly from Briefcase. The 
recipients must have the appropriate software to open the file.

1. Right-click on the selected file in a Briefcase folder. 

2. Select Send as attachment(s). The email compose page opens with the 
file attached.

3. Add the recipient’s email address and complete the email message.

4. Click Send.

Sharing Your Briefcase Folders
You can share your Briefcase folders with other people in your office, with 
external guests, and with the public. When you share your briefcase folders 
with internal users, you can select the type of access the internal users can 
have, either manager which gives full access to view, edit, and add files to the 
shared folder’s content, or viewer, which gives read-only access. External 
guests and the public have read-only access. Anyone you invite to edit or view 
files in your Briefcase can access the Briefcase any time.

To learn more about how to share your Briefcase folders, see Chapter 15, 
Sharing Your Account Folders.
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14      Searching Your Account
This chapter explains how to:

• Use Quick Search 

• Use the search syntax to create your own searches

• Use Advanced Search to easily create complex search queries 

• Save your search query

You can search messages, contacts, appointments, notebooks, pages, and 
files. You can search by:

• Specific words

• Dates and time

• URL

• File size

• Tag

• Whether or not a file has attachments or attachments of a particular file 
type 

There are two mailbox search tools:

Search. This is a quick search that executes the search query displayed in the 
Search text box. The select menu to the right of the Search box enables you to 
select the type of item for which to search.

Advanced. This search opens a new pane and makes it easier to execute 
more complex searches. You can save your advanced search queries and re-
execute them at a later date. 

Search Syntax
If you are familiar with text-match searches or word-processing features such 
as the Find/Change in Microsoft Word, note that the content search in the 
Zimbra Web Client is slightly different from performing a literal string match.
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Zimbra search syntax works as follows:

• It is an exact text search. You can search for phrases, but each word within 
that phrase is matched literally by whole-word only. Spelling variants are 
not allowed. For example, if you search for bananas, messages with 
banana are not a match.

• Search is not case sensitive; South, south, and SOUTH are all the same 
thing.

• These special characters cannot be used in your search text. ~ ' ! @ # $ % 
^ & * () _- + ? / { }[ ] ; : "

• The asterisk * as a wildcard after a prefix is supported. For example, if you 
search for do*, it returns items with the word dog, door, etc.

Searching for content will search the body of a message plus any system-
readable file attachments it may have. A system-readable file attachment is a 
type of file that can be converted to HTML. These attachments include 
Microsoft Office documents (Word, PowerPoint, or Excel), as well as text files.

Using Quick Search 
The search feature is a powerful tool. It provides a quick shortcut to searching 
without keywords. For example, to find all email containing the word tim 
anywhere in the Subject line, To, From, Cc, or Bcc lines, message body, or 
file attachment, simply type tim into the search box and click Search. 

You can enter any value, such as a word, first name, last name, phone 
number, or domain name. To search for contacts in your address books, the 
search field must contain a whole word or number string. For example, to 
search contacts by phone number, you have to enter the full phone number as 
it appears in the contact entry; you cannot search by the area code alone.

To perform a quick search:

1. Enter the search query into the Search field.

2. Select one of the following options from the search type drop-down menu:

Note:   If you do not have a specific feature enabled, you do not see the 
search option.
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•  to search all items in your mailbox

•  to search email messages

•  to search contacts in your personal address book

•  to search the Global Address List

•  to search appointments

•  to search your tasks

•  to search notebook pages 

• to search files

3. Click .

Advanced Search Criteria
The Advanced Search features opens separate panes to perform different 
types of searches. You can open multiple instances of each pane. You might 
want to do this if you are doing AND type searches. 

Refer to the table below for advanced search criteria.

Criteria Description

Basic
Search header information such as From, To, and 
Subject. Search the content of messages and 
attachments for a specific word or phrase.

Attachment
Search for No Attachment, Any Attachment, or Specific 
Attachment. If you select specific attachment, a list of 
attachment types is displayed.
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Searching for Messages with Quick Search
To search for messages using Quick Search:

1. Enter search criteria in the Search box. For example, enter a sender's 
name.

2. Select an option from the Search drop-down menu. Email is the default.

3. Click . Search results are displayed in the Content pane.

4. Click any tab on the menu to exit the search.

Date
Search for messages received after, on, or before a 
selected date. Open two Date panes to search 
between dates.

Domain

Search for messages where the address headers 
(From/To/Cc) contain addresses from certain domains. 
The domains that you can search for are pre-defined 
with check boxes.

Folder Limit search to selected folders only.

Saved Search Open a search query you previously saved.

Size
Search for messages that are larger or smaller than a 
specified size (bytes, KB, or MB).

Zimlets
Search for messages or contacts containing URLs, 
phone numbers, or other objects as defined by your 
administrator.

Status
Search for messages or contacts that are flagged or 
unflagged. Search for messages that are read, unread, 
forwarded, or replied to.

Tag
Search for messages or contacts that have a specific 
tag or a specified set of tags.

Time
Search for messages that arrived within a time-frame, 
such as the last hour, this week, last month, etc.
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Searching for Messages with Advanced Search
To search for messages using Advanced Search:

1. Click Advanced to open the Advanced search area.

The Advanced search panes appear, with the Basic Search pane 
displayed.

2. Depending on your search requirements, click an icon in the toolbar to 
open the appropriate pane. Each time you click an icon, another pane is 
displayed.

3. Enter information in the pane fields.

If you enabled Always Show Search String on the Preference > General 
folder, the search text box updates as you type or make selections.

• Search Execution. When you enter a criterion in a search pane, or as 
soon as you have made any selection change in a search pane, the 
search executes. Therefore, if you enter text in a field, the search 
executes. If you select a radio button, the search executes. Etc.

• Search Results. Items matching the search criteria are listed in the 
Content pane. If the Conversation feature is enabled, conversations 
containing messages that match the search criteria are listed.

4. Refresh. Click  to refresh the search results area.

5. Click  to exit the search.

Advanced Search Example

To search for a specific type of attachment file. For example, you are 
looking for a message with a news clip attached. You don't remember who it's 
from or what date it was sent, but the filename has a .PDF extension.
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How it was done: 

• Select Email from the search drop-down menu. 

• Click Attachments in the Advanced search area to open just the 
Attachments pane. 

• Choose Specific Attachment. A list of check boxes appears beneath the 
radio button. Check the box next to Adobe PDF.

The relevant email messages are displayed in the search results area.

Using * as a Wildcard in Search
The asterisk * can be used as a wildcard in a search to find content with words 
that have similar spellings.  

Use the asterisk * as a wildcard after a prefix. For example, do* returns items 
with the word dog, door, etc. 

Saving a Search Query
If you create a search that you think you will want to use again, you can save 
it. 

To save a search:

1. Create the search query, either by entering text in the Search bar or by 
creating a query with Advanced search.

2. Click  in the Search area to save the search.
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The Save Search dialog appears.

3. Enter a name for the search into the field.

4. Select where to place the saved search. Searches are saved as a folder in 
the Searches section of the Overview pane by default, but you can select 
another folder.

5. Click .

The saved search is displayed in the Overview pane.
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To use a saved search, click the search folder. The search results 
immediately display in the Content pane.

Search Examples
The different panes in the Advanced search area can be used to search by 
different criteria. The following examples include which Advanced search 
panes you would use.

Here are a few possible search examples:

• To search for an attachment that may be one type or another. 
Messages with either PDF attachments or JPEG attachments.

How it was done: Select Email from the search drop-down menu. In the 
Attachments pane, choose Specific Attachment and then check both 
Adobe PDF and JPEG Image.
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• To search for a contact within a specific company. A contact who works at a 
company called Zimbra.

How it was done: Select Contacts from the search drop-down menu. In the 
Advanced search area, open the Basic Search pane. Enter Zimbra in the 
Content field. (You could also do this search without using Advanced 
Search.)

• To search for an item that was tagged. Description of the new 
procedures for your industry, which you had tagged as Industry News.

How it was done: Select All Item Types from the search drop-down menu. 
In the Advanced search area, open the Tags pane. Select the check box 
for the Industry news tag. Note that tags are user-defined, so this 
assumes that you have previously 1) created the tag definition, and 2) 
applied it to objects in your mailbox.

• To search by a date range. Search for a message someone claims to 
have sent you in early December.
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How it was done: Select Email from the search drop-down menu. In the 
Advanced search area, open two instances of the Date pane to set the 
date range. In the first one, set the Date drop-down to is before and select 
an end date. Use the other Date pane to specify is after and a start date. 
You can also search by sender using a basic search. 
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This chapter explains how to:

• Share folders from your Mail, Address Book, Calendar, Tasks, 
Documents notebooks, and Briefcase folders 

• Set up sharing with others 

• Cancel a shared folder

• Accept a share invitation 

• Work in shared folder

• Link to a shared folder 

You can share your mail folders, address books, calendars, task lists, 
Documents notebooks, and Briefcase folders. Sharing your ZWC items lets 
you collaborate with others, letting them make changes to or just view the 
folder details.  The process to share a folder is as follows: 

• The grantor selects the folder to share:  email folder, address book, 
calendar, notebook, task list, or Briefcase folder.

• The grantor decides with whom to share and the access privileges, the 
grantee can have, and then sends them an invitation.

• The grantee accepts the invitation and gets access to the shared folder.

Selecting Access Privileges
From within the appropriate application, you select the folder and specify the 
type of access privileges to give the grantee.  You can share with internal 
users, who can be given complete manager access to the folder or only the 
ability to view the folder. 

You can set permissions per user or group, so everyone does not have to 
have the same permissions to your shared folder. 

You can share with the following:
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• Internal users or groups. You select the type of privileges (role) to grant 
to internal users. The user or group must have a valid address in your 
company’s mail server.

• Viewer. The grantee can read the contents of the shared folder, but 
cannot make changes to the content.

• Manager. The grantee has full permission to view and edit the content 
of a shared folder, create new sub folders, edit and delete files in the 
shared folder.

• Admin. The grantee has complete permission to view, edit, add, 
remove, accept, decline, and administer content.

• None. An option to temporarily disable access to a shared folder without 
revoking the share privileges. The grantee still has the shared folder in 
his mailbox but cannot view or manage activities on the grantor's folder. 

Note:   You can share your Mail folders only with internal users or groups.

• External guests. You create a password for the shared folder that guests 
must enter to view the content. They cannot make any changes to the 
information they view.

• Public. Anyone that knows the URL to the folder can view the content. 
 They cannot make any changes to the information.
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How Sharing Works
The access privileges for each application is described in the following 
sections.

Sharing Your Mail Folders

You can share any of your mail folders, including the Inbox folder and sub-
folders, with valid users within your organization. You cannot share your mail 
folders with external users or with the public. A copy of the shared folder is put 
in the grantee's Folder list on the Overview pane. When the folder is selected, 
the content displays in the Content pane. The grantee do not need to log into 
the grantor's mailbox. 

Grantees that have the manager role have full permission to view and edit the 
contents of the shared mail folder, create new sub-folders, send email on the 
grantor’s behalf, and delete email messages. Grantees with the admin role 
have full permission to view, edit the content of the mail folder, create new 
sub-folders, send email on your behalf, delete email messages, and share 
your mail folder with others.

Scenarios for sharing a mail folder

• Your sales department wants one central mailbox for all email messages 
requesting information about your product, and everyone in sales should 
be able to view email messages immediately when they come in. You can 
give everyone in the department permission to view the mail folder and 
they can copy the messages to their mailbox, or you can give them 
permission to manage the mail folder and they can reply on behalf of this 
address. 

• A manager is often out of the office and does not have time to respond to 
her email messages. When the manager delegates access to her Inbox 
mail folder, her assistant (grantee) can manage the content of her mail, 
respond to messages on her behalf, create folders to organize message in 
that mail folder, and delete messages. 

• Instead of sending email messages to dozens of addresses every time you 
have an announcement, you can identify one of your folders as a public 
folder that contains the email announcements. You can create shared 
access to only specific email addresses and set a password that must be 
entered to view the content, or you can make it a public URL for anyone 
who has the URL can view the content.  
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Sharing Address Book Contact Lists 

You can share any of your address books with other people in your office, with 
external guests, and with the public. Depending on the role you assign to the 
grantee, the shared contacts list can be view-only or manager which has full 
access privileges to edit, add, and delete contacts in the address book. 

Sharing your address book is useful if your address books are for specific 
categories of contacts and you want other users to have access to the names. 

Sharing Calendars

You can share your calendars with other people in your office, with external 
guests, and with the public. Depending on the privileges you assign to the 
grantee, the shared calendar can be view-only, manager, or admin which has 
full access privileges to create meetings, accept or decline invitations, and edit 
and delete activities on the shared calendar. You can also choose if the 
selected user(s) can view your private appointments on the calendar.

Sharing Task Lists, Documents Notebooks, Briefcase Folders

You can share your task lists, Documents notebooks, and Briefcase folders 
with other people in your office, with external guests, and with the public. 
When you share your folders with internal users, you can select the type of 
access the internal users can have: either admin or manager, which gives full 
access to view and modify the content of the shared folder; or viewer, which 
gives read-only access. External guests and the public only can have read-
only access.

Setting Up Shared Folders
When you select the item to share, you can select the top level folder or you 
can select a specific folder under the folder. If you select to share the top-level 
folder, all folders within that folder are also shared. 

1. Right-click on the folder you want to share. 

Note:   When you share your mail folders, you cannot share the Trash or Junk 
folders.

2. Click Share Folder. The Shared Properties dialog displays. Select whom 
to share with; Internal user or groups, External guests, or Public.
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3. Depending on with whom you share, you do the following:

• For Internal users or groups, enter the email addresses and in the 
Role area select the access privileges.

• For External guests, enter guest's addresses and the password to 
enter to view your mail folder.

• For the Public, direct the public to the URL that displays in the URL 
area. For example, you could copy and email this URL to those you 
want to view the page.

4. In the Message area select which type of message to send. This message 
can be sent to internal users and to external guests. The options are as 
follows:

• Do not send mail about this share. No message is sent.

• Send standard message. The standard share notification message is 
sent to the email address.  This message includes the name of the mail 
folder that is being shared, your address, the grantee's address and the 
role assigned, with a list of the allowed actions.

• Add a note to standard message. You can add additional information 
to the standard message.

• Compose email in new window. Create and send a new email 
message.
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5. Click OK. 

Note:   Remember, if you selected Public, you will need to notify the public of 
the URL.

Changing or Canceling Access 
You can cancel the share privileges and edit the grantee's role from the Share 
Properties dialog.

To change access permissions:

1. From the appropriate application, right-click on the shared folder to change. 

2. Select Edit Properties. The Folder Properties dialog opens. This dialog 
displays the names that share the folder. 

3. In the Sharing for this folder section, click Edit by the name to change. 
The Share Properties dialog opens. You can change the privileges.

• Viewer. The grantee can read the contents of the folder, but cannot 
change it.

• Manager. The grantee has full permission to view, edit the contents of a 
folder, add new pages and remove pages.

• Admin. The grantee has complete permission to view, edit, add, 
remove, accept, decline, and administer content.

• None. This is an option to temporarily disable access to a grantor's 
shared folder without revoking the share privileges. The grantee still has 
the folder in their list, but cannot view or manage activities in the folder. 
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4. An email message will be sent to notify the user, or you can select to either 
not send an email message or to send a standard or composed message.

5. Click OK. 

To cancel access:

1. From the appropriate application, right-click on the shared folder. 

2. Select Edit Properties. The Folder Properties dialog opens. This dialog 
displays the names that share the folder. 

3. Click Revoke. A Revoke Share dialog opens. An email message will be 
sent to notify the user, or you can select to either not send an email 
message or to send a customized message.

4. Click OK. The user can no longer access your folder. The user can delete 
the folder from their Overview pane list. 

Accepting an Invitation to Share Items
If you receive an email notice that you have been granted access to share 
another person's mail folder, you can accept or decline the share.

When you accept the share, the shared folder  displays in the specified 
application’s list in the Overview pane.

To accept:

1. Click Accept Share in the email. The Accept Share dialog opens and 
describes the role granted to you.
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2. Before you accept, you can change the folder name and select a color to 
high-light the folder.

3. (Optional) Select to send a confirmation back to the Grantor. 

4. Click Yes. The folder is added to the grantee’s Overview pane. The 
message is moved to your Trash folder.

Working within a Shared Folder
When you accept to share a grantor's folder, the folder is displayed in your 
Overview pane.  When you open the folder, you see the content of the folder. 
 This information is not actually saved in your mailbox.  

• When sharing a Mail folder, the grantees can open the email and if they 
were granted permissions of Manager, they can reply to, forward, or delete 
the message. Copies of the messages the grantee sends are saved in the 
grantor's mailbox, and if the grantee delete something from the grantor's 
mailbox or marks it as spam, the message is moved to the grantor's Trash 
folder or Junk folder. 

If the grantee has access to more than one of the grantor's folders, the 
grantee can 

• Move the contents from one folder to another folder in the grantor's 
mailbox.
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• Copy an email message from the grantor's folders to the grantee’s mail 
folders. The grantor's mail folder also retains a copy.

• Create folders within the shared mail folder and the new folder appears 
in the grantor's mailbox.

• When sharing an Address Book folder, the grantee with admin or 
manager permission can add, delete, and edit contacts in the address 
book.

• When sharing a Calendar folder, the grantee with admin or manager 
permission can add, delete, and edit meetings and appointments on the 
calendar. Depending on the access allowed, grantees with viewer, 
manager, or admin rights can also view the grantor’s private appointments.

• When sharing a Task list, the grantee with admin or manager permission 
can add, edit, and delete tasks in the task list. 

• When sharing Documents notebook, the grantee with admin or manager 
permission can add pages, edit and delete pages in the notebook. The 
version control lets users know when a page was last updated and who 
updated it.

• When sharing a Briefcase folder, the grantee with admin or manager 
permission can add new files to the folder, edit existing files if they have the 
appropriate software, and delete files.  The detailed information shows 
when a file is modified and who modified it.

Linking to Shared Items
In addition to accepting email notification that you have been granted access , 
you can also establish links to shared folders by using the Link to Shared 
dialog. For example, this may be the case when your organization has public 
notebooks that you want to view but not manage. 

Note:   The access privileges you have are set by the grantor. 

1. In the appropriate application, right-click on the application header and 
select Link to Shared. A dialog opens.
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2. To add the shared folder link, you must know the email address of the 
owner and the name of the shared folder. For example, 
Jdoe@example.com created a notebook called Projects with second 
notebook under Projects called Project 1. Jdoe then shares Project 1 with 
you. 

In order to access Project 1, enter the information as follows:

• Email. jdoe@example.com

• Path. projects/project1

• Name. The name auto-completes with the email name and the path. 
You can change this.

• Color.  Select a color from the list (optional)

3. Click OK. The notebook is added to your Notebooks list.
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Managing Your Shared Items
You can view and manage your shared items from Preferences > Sharing. The 
following can be done from this page: 

• Search for folders that have been shared with you but you have not yet 
accepted the share. You can see folders that are being shared through 
distribution lists or by individual users. This information is not saved to the 
page.

• See a list of folders that are shared with you and you have accepted the 
share request. The information displayed includes the owner of the shared 
folder, the type of share and the role granted to you.

• See a list of folders you have shared with others. You can edit the share 
properties, revoke permissions to your share, or re-send the invitation.

• Share a folder directly from this page.
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Appendix A: Standard Zimbra Web Client
Overview
This appendix gives a brief introduction to the standard Zimbra Web Client, 
including features available and navigation overview. The standard ZWC is a 
non-Ajax web UI for poorer connections, legacy browsers, or easier 
accessibility. Some features and navigation are different between the 
advanced and standard clients.

Features Available in the Standard ZWC
The table that follows lists the main features of the ZWC and whether the 
feature is available in the standard ZWC.

Feature Description ADV 
ZWC

STD 
ZWC

General Web Interface

AJAX-based 
end user 
interface

Rich, interactive, web-based interface 
for end user functions 

Online end user 
help

Online end user help accessible 
directly from the end user interface

Themes Ability to customize the colors and 
appearance of the web interface

Cross-Application Features

Drag/Drop with 
drag context

Ability to drag/drop items, with dynamic 
indicators of the number of items being 
dragged and valid drop zones

*Drag and drop functionality is limited 
in the standard client.

  *
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Auto-complete 
addresses

Addresses auto-complete as they are 
being typed, including a dynamically 
updated selection dialog when multiple 
addresses match

Tags Ability to quickly categorize messages, 
contacts, and/or documents by 
attaching "Tags" with user-defined 
names and colors 

HTML 
formatting

Ability to render and create messages, 
appointments, and web documents in 
HTML format

Spell check Option to check and correct spelling in 
a mail message, calendar 
appointment, or web Document 
*Standard – HTML compose must be 
checked

*

Zimbra 
Assistant

Mini dialog for quick actions (e.g. send 
message, create appointment) without 
changing the underlying application 
context

"View as HTML" 
option for 
attachments

Option to quickly view attachments in 
HTML format *

Keyboard 
Navigation

Keyboard shortcuts are available for 
Zimbra Web Client

Note: The keyboard shortcuts differ 
between the advanced and standard 
clients. 

Mail

Paging Left and right arrows are used to 
navigate from page to page. In 
Preferences>Mail users can set the 
number of messages to display per 
page. 
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Conversations Automatic grouping of messages in a 
message thread, enabling efficient 
message organization

Preview pane Ability to view a highlighted message in 
a preview pane

Subscribe to 
RSS/ATOM 
feeds

Ability to subscribe to RSS/ATOM 
feeds

Message print 
and print 
preview

Ability to print a message and see a 
print preview

Message sort Ability to sort messages based on 
subject, date, or sender

Flags Ability to flag/unflag messages/
conversations for follow up

Filters Ability to define filter rules and priorities 
for incoming messages

Away messages Ability to enable/disable a custom 
away message

Signatures Ability to add a custom signature to a 
message

Compose in   
window

Option to popup a separate window 
when composing a   message

Drafts Ability to save in-progress messages to 
a Drafts folder

User-controlled 
forwarding

Ability for a user to set an automatic 
forwarding address and choose 
whether to leave a copy in the primary 
mailbox

Reply with 
attachments 
option

Option to Reply or Reply-All while 
retaining the attachments from the 
original message
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Right-click 
message 
context menu

Right-clicking a message displays a 
menu of actions to take on that 
message (e.g. Mark Read, Reply, 
Delete)

Right-click email 
address context 
menu

Right-clicking an email address 
displays a menu of actions to take on 
that address (e.g. view website, add/
edit contact, create filter, search for 
messages)

Hover over 
attached image 
shows preview

Hovering over an image attachment in 
a message displays a thumbnail 
preview of the image

Create calendar 
appointment 
from message

Ability to drag a message to a mini-
calendar date to create an 
appointment based on the message

Quota indicator Visual indicator of quota and amount of 
quota consumed

Export 
messages as 
ZIP file

Ability to export a set of messages as a 
ZIP file

Reply/Reply-All 
Toggle

Ability to toggle between Reply and 
Reply-All while composing a reply

Persona (Mail 
Identities)

Ability to create multiple identities in 
Zimbra Web Client and use different 
names and mail settings.

Support for 
multiple external 
email accounts 

Within ZWC, users can identify other 
POP email accounts that they have, 
retrieve email from those accounts and 
save in specific folders

Reading Pane 
view can be set

Users can set their default preference 
for viewing messages in the reading 
pane
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User-specified 
default HTML 
settings

Users can set the default font family, 
font size and font color to use when 
composing email messages and 
Documents pages

Ability to insert 
inline images in 
HTML Editor

Users can insert inline images in email 
messages and calendar appointments 

Different 
signatures can 
be defined

Users can define different email 
signatures to use

Checkboxes to 
select mail

Users can check multiple emails in the 
list view to mark as read/unread/tag, 
delete, or to move to a different folder

Message 
priority can be 
set

When sending a message, the priority 
is normal, but it can be set to high or 
low as well

Multiple 
messages can 
be forwarded

Multiple messages can be selected 
and forwarded in one email

Aggregation of 
mail accounts 
using IMAP

Users can aggregate multiple external 
accounts in their Zimbra account using 
IMAP

View the 
number and 
total size of 
items in folder 

Users can right click on a folder to see 
the number of messages and the total 
size of items in folder

Address Book

Import/export 
contacts in CSV 
format

Ability to import/export Contacts in .csv 
format

Multiple 
Address Books 
per mailbox

Ability to create multiple Address 
Books in a single mailbox
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Move/copy 
contacts across 
Address Books

Ability to move/copy contacts from one 
Address Book to another (based on 
access privileges)

Personal 
Distribution 
Lists (Group 
Lists)

Ability to create group contact lists in 
their user Address Books

Calendar

Personal 
scheduling

Ability to schedule personal 
appointments

Group 
scheduling

Ability to schedule meetings and view 
attendees' free/busy information

Recurrences 
and recurrence 
exceptions

Ability to create recurring meetings and 
exceptions to recurring meetings

Resource 
scheduling

Ability to book resources (locations, 
equipment, etc.) for a meeting

Calendar alerts Option to enable an alert popup for 
upcoming appointments

Time zone 
adjustment

Appointments/schedules are 
automatically displayed in the users 
current time zone

Day, Week, 
Work Week, 
Month views

Ability to view calendars in Day, Week, 
Work Week, or Month views

Customizable 
first day of week

User setting for the first day of the 
week; value chosen impacts the Week 
calendar view

Create/drag 
appointment 
inline in 
calendar views

Ability to create an appointment and/or 
drag an appointment's boundaries 
inline in calendar views
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Quick Accept/
Tentative/
Decline from 
calendar views

Ability to  quickly mark Accept/
Tentative/Decline from calendar views

Faded display of 
declined 
appointments

Declined appointments display faded 
so that the user remains aware of their 
occurrence

Calendar print 
and print 
preview

Ability to print calendars in day, week, 
work week, or month views and see a 
print preview

Hover over 
appointment 
shows details

Hovering over an appointment in 
calendar view displays additional 
appointment details

Mini-cal Option to display a miniature calendar 
at all times

Hover over date 
in mini-cal 
shows schedule

Hovering over a date in the mini-cal 
displays calendar information for that 
date

Multiple 
calendars per 
mailbox

Ability for a user to create multiple 
calendars within a single account

Free/busy 
inclusion by 
calendar

Ability for a user to designate which 
calendars will be included in the user's 
free/busy calculations

Subscribe to 
external 
calendars

Ability to subscribe to an external 
calendar in iCalendar (.ics) format

Publish 
calendar in 
iCalendar 
format

Ability to publish/export a calendar in 
iCalendar (.ics) format

Multi-calendar 
overlay views

Ability for a user to view multiple 
calendars overlaid in the same view, 
which each calendar optionally 
represented by a different color
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Import 
calendars as ics 
iCal files

Users can import calendar iCalendars 
(.ics) 

Mark 
appointments 
as private

Appointments can be marked as 
private or public. 

Calendars can 
be for personal 
appointments 
only

Administrators can configure the 
Calendar feature to be able to create 
only personal appointments

Search for 
appointments

Users can search for appointments 
within their calendars

HTML Read-
Only View for 
Public 
Calendars

Public calendars display in  HTML 
read-only format

Tasks

Manage tasks Add tasks and set the start and due 
date, set the priority and keep track of 
the progress and percentage complete

Create task 
folders

Users can organize task lists into 
folders

Sort tasks Users can sort tasks by Status or Due 
Date

Prioritize tasks Users can set the priority of tasks to 
high, normal or low

Tag tasks Individual tasks can be tagged

Attachments to 
tasks

Files can be attached to a tasks

Documents

 Create and use Documents feature

 

Briefcase
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 Create and use Briefcase feature

 

ZimletsTM

 Use Zimlets  

Search

Advanced Search interface for building searches

Cross-context 
search

Ability to search for a specific item type 
(Mail, Contacts, Documents, etc.) or 
across item types

Wildcard 
searches

Ability to search using a prefix plus a 
wildcard

Continuous 
search

When using Advanced Search, the 
search result set updates continuously 
as search conditions are changed

Saved 
Searches

Ability to save searches for 
subsequent one-click re-execution

Sharing

Share with 
internal users 
and groups

Ability to share Address Books, 
Calendars, Task Lists, Document 
Notebooks, and Briefcase folders with 
internal users and groups. They can 
set the permission levels to manage or 
to view-only.

Share with 
External Users 

Ability to share  Address Books, 
Calendars, Task Lists, Document 
Notebooks, and Briefcase folders with 
external users by assigning a customer 
password.. Permission  level view-only.

Share with 
Public

Ability to share Address Books, 
Calendars, Task Lists, Document 
Notebooks, and Briefcase folders with 
the public.  No password is set. 
Permission  level view-only.
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Navigating the Standard Zimbra Web Client 
When you log into the standard Zimbra Web Client you see a full screen view 
similar to the one shown below. 

Refer to the following table when viewing the ZWC.

Share Mail 
Folders

Ability to share Mail Folders with 
internal users and groups. They can 
set the permission levels to manage or 
to view-only

Link to shared 
Mail  Folders

Users can link to an item that has been 
shared with them

Link to shared 
Address Book

Users can link to an item that has been 
shared with them

Link to shared 
Calendar

Users can link to an item that has been 
shared with them

Link to shared 
Task List

Users can link to an item that has been 
shared with them

Link to shared 
Notebooks

Users can link to an item that has been 
shared with them

Link to shared 
Briefcase Folder

Users can link to an item that has been 
shared with them
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Number Description

1

Window Header. Displays the following:

Search Bar 

 and  are displayed on the right

2

Overview Pane. Displays the following:

• User Name – the user name under which you logged in

• Quota Display – your mailbox quota

• Folders – including system folders (Inbox, Sent, Draft, Junk, 
Trash) and folders you created

• Searches – search queries that you created and saved for 
future use while working in the Advance ZWC

• Tags – any tags you have created. Click on a tag to quickly 
see all messages that are tagged with that tag.

3

Toolbar. This bar displays at the top and again under the 
Content pane and displays the following:

Tools Tabs – click a tab to access the different ZWC tools 
available for your account. In this example, Email is open.

Action Buttons – click an action button to perform a task 
available for the application you are currently using. The Move 
to and More Actions fields gives you menu choices available in 
the application.

4
Content Pane. The content of this area changes depending on 
what application is in use. In the Inbox view, it displays all 
messages or conversations in your Inbox. 

Move to… 

This menu displays the moves that you can make within the application you 
are in. In this example, In the email application, the message from Dan Pattern 
is selected and the options for the message are to move to folders in your 
folder list.
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More Action…

This menu displays the different actions that you can make within the 
application you are in. This example is for when you are the email application.

Navigation Functions Not Available

The following navigating features are not available with the standard ZWC 

• Down-arrow menus

• Movable sash

• Tool tips

• Right-click for client features

• Folder information
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Index
accepting an share invitation 209
access privileges, sharing 203
account identities 79
add new contact 93
adding files to briefcase folders 186
address book

export address book 100
import address book 100

address book preferences 153
address book, sharing 206
advanced email features 77
advanced search features 195
attachments

add attachment 40
file extensions 42
supported file types 41
view attachment 23

autocomplete contacts 44
automatic address completion 43
bounced email 50
briefcase folders, sharing 206
briefcase overview 185
briefcase, adding files to 186
briefcase, sending email with link 190
briefcase, viewing files 188
calendar preference, setting reminders 156
calendar preferences, appointment 

options 156
calendar, sharing 206
calendars

appointments 120
color-coding 108
convert contact into meeting request 140
convert message into meeting request 139
create calendar 106
delete appointment 137
delete calendar 117
delete recurring appointment 138
edit appointment 135
export iCal calendar 112
free/busy times 129
import iCal calendar 111
print appointment 139
quick add appointment 123
recurring appointments 133

respond to meeting invitation 141
schedule all day event 132
schedule attendees 128
schedule resources 131
scheduling locations 130
share calendar 115
view calendar 105
view multiple calendars 108

change address book view 92
change appointment 135
change password 147
change time zone 90
check for mail preference 148
color-code calendars 108
compatible browsers 4
contact

delete contact 102
contacts

add contact 93
add contact automatically 98
add contact from email message 95
add names to email message 96
create group contact list 98
edit contact 101
export address book 100
import address book 100
move contact 102
print from address book 101
share address book 103
view 91

content page view 18
convert contact into meeting request 140
convert message into meeting request 139
create appointment 120
create away message 78
create calendar 106
create folder 59
create meeting 120
create persona 80
creating briefcase folders 185
creating task lists 163
customize inbox view 15
default time zone 90, 146
delete appointment 137
delete calendar 117
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delete contact 102
delete folder 61
delete recurring appointment 138
deleting a message

recover message 30
display HTML in email messages 21
display message preferences 148
document notebook, formatting page 178
document notebook, sharing 206
documents overview 175
documents, creating notebooks 175
documents, notebook inserting table 180
documents, spreadsheet 182
edit appointment 135
edit as new, forward message 48
edit contact 101
email attachments 23
email link for briefcase files 190
email signatures 48
email views 17
email virus 25
emails

set email notification 77
export address book 100
export task lists 173
exporting iCal calendar 112
external accounts

add account 84
receive messages from 83
retrieve email 82
to set up 83

feature comparison between standard and ad-
vanced clients 215

features
advanced email features 77
away message 78
set email notification 77

file extensions 42
filters 63

actions 64, 73
comparison operators 73
conditions 63, 71
create filter 65
edit filter 70
wildcards 74

find attendees 128
flag email messages 58
folders 28

create custom folder 59
delete folder 61
Draft folder 45
junk folder 31
move email messages 29
rename folder 60

Sent folder 45
sharing 29
trash folder 30
using folders 59

folders, shared 158
forgot password 6
forward message, edit as new 48
forwarding address 50
forwarding email 47
free/busy times 129
general preferences 146
group contact list 98
HTML editor 38
html preference 148
import address book 100
importing iCal calendar 111
importing task lists 172
language, setting preferences 146
linking to shared items 211
logging in to ZWC 4
mail folder, sharing 205
mailbox quota, quotas 89
managing spam 32
mandatory spell check 151
marking email as unread 24
marking message as read preferences 148
message notification preference 150
messages

add attachment 40
add contact automatically 98
add name from address book 96
autocomplete contacts 44
automatic address completion 43
bounced email 50
composing 35
content page view 18
conversations 18
display HTML in messages 21
email signatures 48
email views 17
empty junk folder 32
flag a message 58
forwarding email 47
HTML editor 38
marking email as junk 32
move email messages 29
parts of a message 22
print message 26
reading email 20
reading pane 20
reply to email messages 45
save emails in Sent folder 45
saving messages 45
sort messages 30
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spell check 38
view attachments 23

mini-calendar 155
mobile device, wiping 159
move contact 102
moving message preference 149
multiple selections 11
notebook, creating 176
organize email 27

folders 28
out-of-office message 78
password, changing 147
personas 79

create persona 80
POP access 150
preferences

change password 147
language 146
save 145
theme 146
time zone 146

preferences, address book folder 153
preferences, composing message 151
preferences, general folder 146
preferences, mail folder 147
preferences, mobile devices 159
preferences, read receipt 150
preferences, setting up 145
preferences, sharing folder 158
preferences, signatures folder 152
print appointment 139
print from address book 101
printing an email 26
printing task lists 171
private view of appointments, setting 155
public view of appointments, setting 155
purge email messages 31
quick search 194
quickadd appointment 123
read receipt preference 150
reading email 20
receiving messages preferences 149
recurring appointment 133
reminder, setting in Calendar 156
rename folder 60
reply to email 45
respond to meeting invitation 141
retrieve email from external account 82
return receipt request 43
revoking share privileges 208
rich-text editor 178
RSS feed 86
save emails 45
save search query 198

saving preferences 145
schedule attendees 128
scheduling location 130
scheduling resources 131
search 193
search syntax 193
search, advanced 195
search, default message search preference 149
search, save 198
search, wildcard 198
session timeout 6
set email notification 77
set forwarding address 50
share address book 103
share calendars 115
shared folder, viewing 158
sharing access privileges 203
sharing your account 203
sharing, accepting an invitation 209
sharing, cancelling access 208
sharing, working within a folder 210
shortcuts tab 161
signatures 48

create signature 48
default signature 49

spell check 38
spell check, mandatory 151
standard web client 215
standard web client feature comparison 215
subscribe to RSS feed 86
tables, inserting in notebook pages 180
tags 53

assign 56
create 53
delete 58
remove 57

task list overview 163
task list, creating 163
task lists, exporting 173
task lists, importing 172
task lists, sharing 206
tasks, moving 170
tasks, sorting 171
theme, preferences 146
time zone 90
undeliverable email 50
view calendar 105
view contacts 91
view multiple calendars 108
viewing files in briefcase 188
virus safety 25
Zimbra assistant 11

shortcut 12
Zimbra Web Client
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attachments 23
content page view 18
customize inbox view 15
email views 17
forgot password 6
link external accounts 82
logging in 4
navigation 6
printing an email 26
shortcut keys 13
user interface and shortcuts 9

Zimbra web client
components 2
mailbox quotas 89

zimlets 161
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